# Contents

## Preface

<table>
<thead>
<tr>
<th>1 Overview</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Guide</td>
<td>1</td>
</tr>
<tr>
<td>Overview of Oracle Transactional Business Intelligence</td>
<td>1</td>
</tr>
<tr>
<td>Oracle Business Intelligence Enterprise Components</td>
<td>1</td>
</tr>
<tr>
<td>Overview of Creation and Administration of SCM Analytics and Reports</td>
<td>2</td>
</tr>
<tr>
<td>Security Overview of SCM Analytics and Reports</td>
<td>3</td>
</tr>
<tr>
<td>View Analytics and Reports</td>
<td>4</td>
</tr>
<tr>
<td>Reports and Analytics Work Area and Panel Tab</td>
<td>6</td>
</tr>
<tr>
<td>Business Intelligence Catalog</td>
<td>7</td>
</tr>
<tr>
<td>Where to Save Analytics and Reports</td>
<td>9</td>
</tr>
<tr>
<td>Do I need to create copies of predefined reports and analyses for each user?</td>
<td>10</td>
</tr>
<tr>
<td>What happens to modified analytics and reports when an update is applied?</td>
<td>10</td>
</tr>
</tbody>
</table>

## 2 Setup and Configuration

<table>
<thead>
<tr>
<th>2 Setup and Configuration</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Setup and Administration</td>
<td>11</td>
</tr>
<tr>
<td>Map to Work Areas</td>
<td>11</td>
</tr>
<tr>
<td>Set Up Currency</td>
<td>12</td>
</tr>
<tr>
<td>Configure Business Intelligence Publisher</td>
<td>18</td>
</tr>
<tr>
<td>Configure Deep Links</td>
<td>26</td>
</tr>
<tr>
<td>Set Up the Delivery Channel</td>
<td>30</td>
</tr>
<tr>
<td>Embed Analyses and Dashboards</td>
<td>34</td>
</tr>
<tr>
<td>Supply Chain Management Repository and Session Variables for Business Intelligence</td>
<td>35</td>
</tr>
</tbody>
</table>

## 3 Subject Areas

<table>
<thead>
<tr>
<th>3 Subject Areas</th>
<th>39</th>
</tr>
</thead>
<tbody>
<tr>
<td>How Data Is Structured for Analytics</td>
<td>39</td>
</tr>
<tr>
<td>SCM Subject Areas in Oracle Transactional Business Intelligence</td>
<td>40</td>
</tr>
</tbody>
</table>
4 Flexfields
Overview of Flexfield Use in Analyses
Configure Key Flexfields for Transactional Business Intelligence
Configure Descriptive Flexfields for Transactional Business Intelligence
Configure Extensible Flexfields for Transactional Business Intelligence
Import Changes to Flexfields Automatically
Disable Flexfields as BI-Enabled
Dimensions Supported by Descriptive Flexfields

5 Analytics Modification
Overview of Analytics Creation and Modification
Analyses
Cross-Subject Area Joins
Dashboards
FAQs for Analyses and Dashboards

6 Reports Modification
Overview of Business Intelligence Publisher
Style Templates
Subtemplates
How You Create and Edit Reports
How You Access and Modify Report Components
How You Modify Copies of Predefined Reports
How Links Between Original and Modified Reports Are Managed
Layouts
Data Models
New Reports
Configurable Email Notifications

7 Analytics and Reports Management
Manage Folders
Briefing Books
Schedule Analytics and Reports
Add Analyses to Application Pages
## Maintenance and Migration 117

- How to Tune Performance for Analytics and Reports 117
- Review SQL Statements Used in Analyses 117
- Localize Catalog Captions 118
- Move Analytics 118
- Row Limits in Analyses 120
- About Warehouse Column Errors in Transactional Analyses 120
- Apply Preferences in BI Publisher 120
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons ❓ to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Overview

About This Guide

If you administer or work with business intelligence, this guide is for you. You can modify, create, and tailor analyses, reports, and dashboards to the content needs of your line of business or company.

Overview of Oracle Transactional Business Intelligence

Oracle Transactional Business Intelligence (OTBI) provides embedded real-time analytics, reports, and dashboards based on real-time transactional data in Oracle Fusion applications, allowing role-based, contextual analysis and reporting in your applications.

Analyses, reports, and dashboards are embedded and available from the Reports and Analytics panel tab in many of your application pages and work areas, and link directly to transactions and decision points. In addition to the prebuilt analyses and reports, ad-hoc analysis against relevant subject areas allows creation of new analyses and revision and changes to existing analytical objects.

OTBI provides services that allow you to create ad-hoc analyses, interactive dashboards or pixel perfect formatted reports, download or schedule reports and save reports as briefing books. Administrators can create user-defined folders and set permissions on them, configure privileges on BI objects, export and import user-defined string captions, and access query log files. However, you can't access BI Server, Catalog Manager, or associated server configuration files and system catalog files.

Oracle BI Enterprise Edition (OBIEE) components available in OTBI include:

- BI Interactive Dashboards: highly interactive dashboards
- BI Delivers: proactive business activity monitoring and alerting
- BI Publisher: enterprise reporting and distribution of pixel-perfect reports

OBIEE components not available in SaaS BI include:

- BI Server: processes user requests and queries in underlying data sources.
- Catalog Manager: a tool for performing online and offline management of the business intelligence catalog and BI objects.

Oracle Business Intelligence Enterprise Components

Business intelligence analytics and reports in the application are provided by the Oracle Business Intelligence Enterprise Edition suite. You can access many information sources about working with Oracle Business Intelligence Enterprise Edition.
The information resources cover the following areas:

- Oracle Business Intelligence Enterprise Edition
- Oracle Business Intelligence Publisher

**Oracle Business Intelligence Enterprise Edition**

Oracle Business Intelligence Enterprise Edition provides predefined and ad hoc analysis against your transactional data.

- Create and work with analyses, dashboards, and advanced analytical content, including dashboard prompts, conditions, actions, and key performance indicators.


**Oracle Business Intelligence Publisher**

Oracle Business Intelligence Publisher is used for reports.

- Run and view reports.

See: Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Publisher

- Create and edit reports, layouts, and templates and subtemplates.

See: Oracle Fusion Middleware Report Designer's Guide for Oracle Business Intelligence Publisher

- Create data models and use the Data Model Editor.

See: Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher

**Overview of Creation and Administration of SCM Analytics and Reports**

Business intelligence enables you to analyze data to gain insight that you can act on, gathering information to meet specific requirements. You can use different types of predefined analytics and reports, or create and edit them, to support your business needs.

**Types of Business Intelligence**

This table describes the purpose of analyses and reports.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>An interactive display of data, for example in a table or graph.</td>
<td>To summarize or break down simple, real-time data, and help you make short-term decisions.</td>
</tr>
<tr>
<td>Type</td>
<td>Description</td>
<td>Purpose</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dashboard</td>
<td>A collection of analyses and other content, presented on one or more pages, or tabs.</td>
<td>To get various pieces of information about a particular subject.</td>
</tr>
<tr>
<td>Report</td>
<td>Output of data in a readable, predefined format.</td>
<td>To get high-volume data in an output optimized for printing, including documents to support internal operations, statutory requirements, and other business needs.</td>
</tr>
</tbody>
</table>

For a list of predefined analyses and reports, see Oracle Supply Chain Management Cloud: View Supply Chain Management Reports and Analyses on the Oracle Help Center.

**Modification of Analyses and Reports**

You can create and edit analyses and reports for your own use. Or, if you have the appropriate roles, you can make modifications for others. For example, you can:

- Add or remove columns from an analysis.
- Change the branding logo on report output.
- Create a dashboard to include your most commonly viewed analyses.

**Setup and Administration**

Administrators perform setup and administration tasks to manage how you or how other users use and modify analyses and reports. For example, you can:

- Configure Oracle Business Intelligence Publisher, the tool used for generating and modifying reports.
- Define *flexfields* to provide attributes that can be used in analyses.
- Archive analyses and reports and move them from one environment to another.

**Related Topics**

- Oracle Supply Chain Management Cloud: View Supply Chain Management Reports and Analyses
- Oracle Supply Chain Management Cloud: View Setup Reports and Analyses

**Security Overview of SCM Analytics and Reports**

All users with appropriate roles can create and access analyses and reports based on role access to subject areas and catalog folders.

Analyses and reports are secured by applying job roles with associated duty roles to users. Duty role assignments determine access to subject areas for analyses as well as catalog folders. For information about the job and duty roles...
provided with SCM and how to modify your security model by creating job roles and assigning duty roles to them, see the Oracle SCM Cloud: Securing Oracle SCM Cloud guide.

In addition to folder and object access, duty roles also determine data security. Each of the duty roles that provides access to subject areas and catalog folders is granted one or more data security policies that allow access to the data.

Related Topics
- Oracle SCM Security Reference

View Analytics and Reports

Video

Watch: This video tutorial shows you how to find analytics and reports, and how to make the most of the viewing features. The content of this video is also covered in text topics.

Procedure

Watch video

You can view analyses, dashboards, and reports on the pages and infolets you usually work with, or navigate directly to them in the business intelligence catalog using the Reports and Analytics work area and the Reports and Analytics panel tab. You can also view analytics in infolets.

View Analytics in Infolets
Use your favorite infolet pages to find analytics.

1. Explore frequently used infolet pages using the page controls and Previous and Next icons.
2. You may find analytics displayed in infolets with summaries and aggregations or performance metrics.
3. Click an infolet to open a detailed report, for example to view the details of transactions that are aggregated as a total.
4. Click Done to return to the infolet page.

View Objects in Familiar Work Areas and Pages

Use analyses, dashboards, and reports available in the pages and work areas you usually work with.

1. Explore frequently used pages, where you may find one or more analyses and reports available as links or embedded in parts of the page, including tabs or panel tabs.
2. Some work areas have a Reports and Analytics panel tab, in which you can explore the catalog folders for analyses and reports specific to the work area and, if you have permission, map additional objects to the work area.
   a. Open the panel tab.
   b. Expand the Shared Reports and Analytics folder and explore the available content.
c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a dashboard.

d. Click View to view the object.

View Objects in the Reports and Analytics Work Area

Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, and report you have access to.

1. Click **Navigator > Tools > Reports and Analytics**.
2. Filter and search for objects:
   a. Optionally, select from the filter list to refine results by object type.
   b. Enter a name or partial name and click **Search**. To view objects you have marked as favorites, select **Favorites** in the list. Select **Recent Items** to view objects you have recently worked with, or a recent search to run it again.
   c. In the search results, use the icons to identify the type of the objects.
   d. Locate an analysis, dashboard, or report and select it, then click **More** and select **View**.
3. In the catalog breadcrumb, you can also browse the catalog folders for analytics and reports.
   a. Click the **Hierarchical Selector** for All Folders and click **My Folders** or **Shared Folders** to explore their subfolders or contents to locate objects.
   b. Click **More** for an object, and then select **View** to open it, or **Edit** to modify it.

View Analyses

An analysis queries against your company’s data and gives you answers to your business questions. Analyses are visualizations, such as charts and tables, of a specific set of data, and may appear in your frequently used pages, or as components of a dashboard.

To view analyses:

1. From the catalog folders or search results, open an analysis to view.
2. Click **Refresh** to rerun the analysis and refresh its data.
3. Click **Print** and select either Printable PDF or Printable HTML to open a printable version of the analysis.
4. Click **Export** to export analysis data in various formats, for example PDF, Excel, PowerPoint, and XML.

Use Dashboards to View Grouped Analyses

Dashboards are a collection of analyses grouped together to return data. A dashboard contains analyses, prompts which filter information, and other objects that are presented on one or more pages.

1. From the catalog folders or search results, open a dashboard to view.
2. If available, select values for dashboard prompts to filter the dashboard.
3. Click **Apply** to refine the results of all of the analyses in the dashboard.

View Reports

Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, click a report's name to view it.
2. Click the **View Report** icon.
   a. Choose whether you want the report displayed as HTML or PDF for printing. Because it's optimized for printing, often PDF provides the best print results.
You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also:
   - Click **Edit** to edit the report properties, layout, and data model.
   - Click **Report History** to view details about when the report was submitted in the past.
   - Click **Schedule** to schedule the report to be run.

Reports and Analytics Work Area and Panel Tab

You can quickly view or run analytics or reports relevant to your work in the Reports and Analytics work area and panel tab. The panel tab is available in many work areas and contains links to analytics and reports specific to the work area. You can also click **Navigator > Reports and Analytics** to open the Reports and Analytics work area, which contains links to all the analytics and reports that you have access to.

You can open the Shared Folders and, if you saved any personal reports or analytics, My Folders. Here are some examples of the objects that may be available in the hierarchy of folders.

- **Analysis**: Data in an interactive format, for example a table or graph.
- **Dashboard**: A collection of analyses and other content, presented on one or more pages, or tabs.
- **Report**: Data in a predefined, printable format, often registered as a scheduled process so you can submit and monitor the report as you would any process.

Reports and Analytics Work Area

The Reports and Analytics work area is a central place for you to quickly search for and run analytics and reports that are related to your work. The work area opens at the highest level of the catalog's folder hierarchy with all objects you have marked as favorites.

Here are some things you can do in the Reports and Analytics work area.

- Search the catalog by object type and name, or use saved searches.
  - Optionally, select an object type in the list to search for analyses, reports, or dashboards.
  - Enter a name or part of a name and click **Search**. Select from the saved searches, including Favorites and Recent Items, to quickly access frequently used objects.
  - Optionally, click **Add Favorites** for an object to mark it as a favorite.
- View and edit analyses and reports.
- Navigate the catalog's folder hierarchy using the folder breadcrumb.
  - Click the **Hierarchical Selector** for All Folders and select **My Folders** or **Shared Folders** to begin navigating the catalog folder contents.
  - Click a folder in the folder breadcrumb or the results to navigate to it.
  - Click the **Hierarchical Selector** within the folder breadcrumb to navigate to a parent folder and select one of its subfolders in the catalog.
- View your favorite analyses and reports and mark objects as favorites.
  - Select **Favorites** in the Saved Searches to display your favorite objects.
b. Click **Add Favorites** for an object to mark it as a favorite.

c. Click **Remove from Favorites** to remove an object from your favorites.

- Create and edit analyses and reports.
  
a. Click **Create** and select **Report** or **Analysis**.
  
b. Use wizards to create your analysis or report.

- Click an object’s path to navigate to its catalog folder.
- Click an object’s name to open it.
- Click **Browse Catalog** (or click More for a specific report, dashboard, or analysis) to use additional features.

### Reports and Analytics Panel Tab

You may find the Reports and Analytics panel tab on some work areas. Click the **Reports and Analytics** icon to open the panel tab. If you have permission, you can create analyses and reports by clicking **Create** and selecting an object. Open the folders to view mapped analyses and reports for the work area, and click their names to view details and to open or edit them.

### Available Catalog Folders

This table describes what's in the folders of the Reports and Analytics work area and panel tab.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Folders</td>
<td>All of the analyses and reports that you saved for your own use only.</td>
</tr>
</tbody>
</table>
| Shared Folders       | - Reports and Analytics work area: all of the analyses and reports that you have permissions to access, including any in the Custom subfolder. Place your shared analyses and reports in the Custom folder to protect them during upgrades.  
                        - Reports and Analytics panel tab: All predefined analyses and reports that are relevant to your role and have been mapped to the work area. |

### Related Topics

- Set Up the Reports and Analytics Panel Tab
- Create and Edit Analyses Using a Wizard
- How You Create and Edit Reports

### Business Intelligence Catalog

There are two major work areas for analytics administration. The main Engagement interface is where your users view the analytics administrators set up in user work areas and on the infolet pages. The second area is the business intelligence catalog. Reports, analyses, dashboards, and other business intelligence (BI) objects are stored and administered in the business intelligence catalog. BI is where you build and edit analytics for your user work areas. You can toggle back and forth between the two areas.
Navigate to the Catalog

1. Click **Tools > Reports and Analytics** in the Navigator.
2. In the Reports and Analytics work area, click the **Browse Catalog** button.

Objects in the Catalog

The catalog stores the BI objects in a folder structure of individual files, organized by product family.

BI objects and reports are organized in the following folder hierarchy:

- Shared Folders (parent)
- Product family (example: Financials)
- Product (example: Payables)
- Report groups (example: Invoices)
- Dashboard reports
- Data Models
- Report Components
- BI Publisher reports
- Prompts

The following table describes the common BI objects that you find in the catalog:

<table>
<thead>
<tr>
<th>Catalog Object</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>Analyses are used for infolets, the Sales pages, and on object pages such as Opportunities.</td>
<td>Analytics library</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Dashboards organize analytical content and catalog objects, and present them in a meaningful way.</td>
<td>Reporting group folder</td>
</tr>
<tr>
<td>Dashboard Prompt</td>
<td>Dashboard prompts allow users to filter dashboard content using provided values.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters are used in dashboards and analyses.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Report</td>
<td>Reports are operational reports in printable format created in Business Intelligence Publisher.</td>
<td>Analytics library</td>
</tr>
</tbody>
</table>
### Catalog Object

<table>
<thead>
<tr>
<th>Catalog Object</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Model</td>
<td>Data models are used by reports created in Business Intelligence Publisher.</td>
<td>Data Models folder</td>
</tr>
<tr>
<td>Sub-template</td>
<td>Sub-templates are used by reports created in Business Intelligence Publisher.</td>
<td>Reporting group folder</td>
</tr>
</tbody>
</table>

### Where to Save Analytics and Reports

You save *analyses, dashboards, and reports* in the *business intelligence (BI) catalog*, along with other objects, including prompts and filters. The catalog has a hierarchy of folders, starting with My Folders and Shared Folders. One important folder is Custom, which you find in Shared Folders and use to store your modified analytics and reports.

#### My Folders

You're the only one who can access anything that you save in My Folders. You can see your saved items in My Folders on the Reports and Analytics *work area*, but not in My Folders in the Reports and Analytics panel tab on any other work area. The only exception is when you create an analysis using the wizard in the Reports and Analytics work area, and save it in My Folders. In this case, the analysis is available in any panel tab on all work areas.

#### Shared Folders

If you have the appropriate *roles*, you can also save in Shared Folders so that your modified analytics or reports are available to anyone with the correct access. You should save objects in the Custom subfolder, which has subfolders organized by product family.

Regarding predefined analytics and reports in Shared Folders:

- You should save a copy of the predefined analysis or dashboard in the corresponding product family subfolder in the Custom folder, and edit only the copy. Directly edit predefined analytics only when necessary, to make sure that any references to the analysis or dashboard still work properly.

- For predefined reports only, you can use a special Customize option to copy the report and also the folder structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the original.

#### Custom Folder

Keep all modified analytics and reports in the Custom folder so that:

- You ensure that modified copies of those objects are not affected during upgrades, which can change predefined analytics and reports outside the Custom folder. You might lose changes saved outside the Custom folder during upgrades.

- You can easily find modified objects.

- You can edit objects in the Custom folder without compromising security on the original objects.
When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom folder. An administrator can reset the permissions on the object and the folder that it’s in.

**Related Topics**
- How You Create and Edit Reports
- Overview of Analytics Creation and Modification
- How You Modify Copies of Predefined Reports

**Do I need to create copies of predefined reports and analyses for each user?**

You don’t need to create multiple versions of the same analysis or report for different users. When you view an object, it includes only the data that you have permission to view from your data security profile. In analyses and reports with hierarchical dimensions, you see information from your level in the hierarchy and downward in the hierarchy.

**What happens to modified analytics and reports when an update is applied?**

When saved in the Custom subfolder within Shared Folders, or in My Folders in the business intelligence (BI) catalog, modified **analytics** and **reports** are preserved during an update. Any modified objects in the Custom folder are preserved in any update. Changes to existing analytics and reports outside the Custom folder, including those you create, are preserved only if the update doesn’t include a new version of those BI objects. If the update includes a new version of a predefined object that you edited outside the Custom folder, then:

- The new version overwrites the existing predefined object.
- A copy of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it’s a new version.

If the update includes a new version of both the predefined object and a folder in its file path, then:

- The new folder, along with the new version of the object, overwrites the existing predefined folder and object.
- A copy of the existing folder (along with your edited object) is automatically created. The folder is renamed to indicate that it’s a new version, but your edited object is not renamed.

**Note:** Future updates won’t affect renamed objects or anything within a renamed folder.
2 Setup and Configuration

Overview of Setup and Administration

Tools for Administering Analyses and Reports

You can use several different tools to manage and administer your analytics. Analytics can be reports or analyses, depending on how you intend to display and distribute them.

These components support modification and administration of your analyses and reports:

- Use the Business Intelligence catalog to interact directly with your reports and analyses. Use this interface to manage permissions, properties, and the organization of your analyses and reports.
- Use the Oracle Business Intelligence Publisher administration pages to configure settings specific to the running and scheduling of operational reports, such as setting up your delivery servers, managing scheduler work load, and setting run-time properties for reports.

Map to Work Areas

Set Up the Reports and Analytics Panel Tab

You can find the Reports and Analytics panel tab in many work areas, and the analytics and reports you see in it depend on the work area. You can define what’s available for a specific work area, by mapping reports from the business intelligence (BI) catalog to that work area. In this mapping context, reports refer to both analytics and reports. Your changes apply to all users who have access to the work area you’re mapping.

Mapping Reports from Your Work Area

To map reports to the work area that you’re in:

1. Expand the Reports and Analytics panel tab.
2. Click the Edit Settings icon in the panel tab.
   You see all the reports that are currently mapped to your work area.
3. Click Select and Add.
4. Find the report in the catalog and select it.
5. Click OK.
6. To remove any mapping, select the report and click Remove.
7. Save your work.

Mapping Reports to Any Work Area

To map reports to any work area that you have access to:

1. In the Setup and Maintenance work area use the Map Reports to Work Areas task.
2. Select the application of the work area you want to map to.
3. Select the work area.
4. Click **Search** and see all the reports that are currently mapped to that work area.
5. Click **Select and Add**.
6. Find the report in the catalog and select it.
7. Click **OK**.
8. To remove any mapping, select the report and click **Remove**.

   **Tip:** Click **Synchronize** to remove all mappings to any reports that are no longer in the catalog. You synchronize all work areas, not just the one you're mapping.

9. Save your work.

**Related Topics**
- Set Up Reports for Scheduling
- Reports and Analytics Work Area and Panel Tab

**Why can't I see reports when mapping reports to work areas for the Reports and Analytics panel tab?**

Either no reports are currently mapped to the **work area** you select on the Map Reports to Work Areas page, or you don't have access to the reports that are mapped.

Similarly, when you're selecting a report to map, you can see only the reports that you have access to. Ask your administrator to either:
- Assign you roles that have access to the reports you want to map to work areas.
- Grant the Reports and Analytics Region Administration Duty to someone who already has access to those reports.

**Why can't I see reports when I edit settings for the Reports and Analytics panel tab?**

In the Edit Settings window, you might not see a currently mapped report because you don't have access to it.

Similarly, when you're selecting a report to map, you can see only the reports that you have access to. Ask your administrator to either:
- Assign you roles that have access to the reports you want to map to work areas.
- Grant the Reports and Analytics Region Administration Duty to someone who already has access to those reports.

**Set Up Currency**
Set Currency Preferences for Analytics

Engagement applications let you to decide how currency is shown in the application, as well as preferences for how analytics show currency and calculate exchange rates. Currency can be set in different regional currency types, depending on where you do business and what currency types you want to see.

There are three ways you set up currency:

- **User Currency** - Set by the business user in Regional settings. This setting applies to the entire application interface for that user only. The currency options available are set by your application administrator.

- **Analytics Currency** - Set by the business user in BI in My Account settings in the Reports area. The setting applies to that user only and only relevant for report production.

- **Corporate Currency** - Set by the application administrator. This setting applies to all users in that company.

Set General User Currency

User currency settings determine the currency used as the default for what you see in your application. User currency applies to your entire interface for your signed-in session.

1. Navigate to **Tools, Set Preferences**.
2. Select **General Preferences > Regional**.
3. Select the preferred currency to be used. Available currencies include those set up for your company by your application administrator.

Set Analytics Currency

The analytics currency settings determine the currency type that is displayed in all your analytics. It also determines how and when your currency conversion rates are calculated.

1. Navigate to **Business Intelligence**.
2. Click **Analytics** in the navigator menu.
3. Click **Browse Catalog**.
4. Click your user name and select **My Account**.
5. Go to the **Preference**.
6. Select your choice in **Currency**.

This shows the currency display options for users:

<table>
<thead>
<tr>
<th>Currency Display Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entered Currency</td>
<td>Currency used on a transaction.</td>
</tr>
<tr>
<td>&lt;Application&gt; Currency</td>
<td>Currency set up in each respective Cloud application as the common Corporate currency used company-wide.</td>
</tr>
<tr>
<td>User Preferred Currency using Simple Currency Management</td>
<td>Conversion to User Preferred Currency is performed at the time your run the report, and is calculated from the Corporate currency based on the last time the record was updated and saved or closed.</td>
</tr>
</tbody>
</table>
Currency Display Type | Description
--- | ---
**User Preferred Currency using Advanced Currency Management** | Conversion to User Preferred Currency happens on the date you run the report, and uses the currency indicated on the record.

Set a Default Currency Conversion Option for All Users

By default, your currency is converted to the corporate currency with a method we call "User Preferred Currency Using Simple Currency Management". This simple setting provides the best run-time performance because when you run a report, the application doesn’t have to look up the rate for each transaction. The currency was converted to your corporate currency at that day’s rate when you updated and saved the record. Otherwise, the application cycles through each record at run-time and converts the currency one record at a time to the exchange rate in effect at the time. For more information see, How User Preferred Currency Exchange Works.

But you can also standardize the setting for all system users, by setting the default preference to another option, such as CRM Currency or User Preferred Currency Using Advanced Currency Management.

To change the default currency setting for all users, administrators need to add a profile option and a corresponding value. Note that when administrators change the default currency setting for users in their organization, individual users can still override that setting and select their preferred currency in My Account.

The following table shows the profile option code parameters to override the default currency setting.

<table>
<thead>
<tr>
<th>Profile Code</th>
<th>Profile Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BI_DEFAULT_CURRENCY_CONVERSION</strong></td>
<td>CRM Currency - Defaults to Application Currency.</td>
</tr>
<tr>
<td><strong>BI_DEFAULT_CURRENCY_CONVERSION</strong></td>
<td>User Preferred Currency 1 - Defaults to User Preferred Currency Simple Currency Management.</td>
</tr>
<tr>
<td><strong>BI_DEFAULT_CURRENCY_CONVERSION</strong></td>
<td>User Preferred Currency 2 - Defaults to User Preferred Currency Advanced Currency Management.</td>
</tr>
</tbody>
</table>

Set a Global Currency Conversion Profile

Set a global currency conversion method for all your users by creating a currency profile. Only administrators can create currency profiles.

1. In Setup and Maintenance, go to Manage Profile Options.
2. Enter the following values:
   - **Profile Option Code**: BI_DEFAULT_CURRENCY_CONVERSION_METHOD
   - **Profile Display Name**: BI Default Currency Conversion Method
   - **Application**
Module

Start Date: Provide previous day's date to proceed to next step to define values.

3. Click Save and Close.
4. In the Manage Profile Options dialog box, you see your new profile. Check the Enabled box for Site.
5. Click Save and Close.

Related Topics
- Update Existing Setup Data

Define Currency Profile Values

After you create your currency profile, the last step is to define the profile value. This step defines which currency management option is assigned to that profile.

1. In the Setup and Maintenance work area, use Manage Administrator Profile Values.
2. In Profile Option Code search for your profile: BL_DEFAULT_CURRENCY_CONVERSION_METHOD.
3. In Manage Administrator Profile Values, click Add (+ icon).
4. Select Site as the Profile level.
5. Enter "User Preferred Currency 2" in Profile Value.
6. Click Save and Close.

How User Preferred Currency Exchange Works

The simple and advanced user-preferred currency choices determine how and when your currency exchange rates are calculated for your reports. For both simple and advanced currency management, when you save or close a report, the application sets the exchange rate at that time. The option you choose impacts how quickly your reports are generated at run time. Each case includes trade-offs, as detailed in the examples.

User Preferred Currency using Simple Currency Management

The advantage of this option is performance - the application doesn't have to look up the rate for each transaction because when you close or save a record, the application converts it to your corporate currency at that day's rate. When you run the opportunity report, the application multiplies that value by your preferred currency exchange rate for the date you run the report. This eliminates the need for the application to cycle through each record, and calculate the corresponding exchange rate to your preferred exchange rate at the time that record was closed or last saved. It simply takes the value on record for the original transaction exchange to corporate currency, and multiplies it by your preferred currency exchange rate at the time your run the report.

As an example of user preferred currency using simple currency management, a user updates and saves or closes an opportunity record with associated revenue of one million Indian Rupees on January 31st with an exchange rate of 0.01403 Rupees to one US Dollar. The user then runs an opportunity report in US Dollars on March 31st. In the report, the US Dollar Corporate Currency is set at the January 31st rate it was saved at, in this case reporting as $14,030, or one million multiplied by 0.01403. Finally, an opportunity report on March 31st in Euros uses the March 31st conversion rate for US Dollars to Euros of 0.75017 to convert the recorded US Dollar amount into Euros, in this example one million multiplied by 0.1403, which is the January 31st Rupee to US Dollar exchange rate, multiplied by 0.75013, which is the March 31st rate for Euros. This requires less processing, because the January 31st Rupee to US Dollar exchange rate, while not exact on March 31st, is used as the basis for the calculation of the March 31st opportunity revenue conversion to Euros at the later exchange rate.
The following figure describes an example of user preferred currency using simple currency management.

User Preferred Currency using Advanced Currency Management
This option provides a more precise exchange rate, since it goes through each record to determine the rate on the date the record was updated or closed. The downside of this option is performance. Your reports will take longer to run. The application has to cycle through each record and match currency exchange rates to the date the record was closed or updated and saved.

As an example of user preferred currency using advanced currency management, a user updates and saves or closes an opportunity record with associated revenue of one million Indian Rupees on January 31st, when an exchange rate of 0.01050 Rupees to one Euro applies. The user then runs an opportunity report on March 31st. In the report, the User Preferred Currency of Euros is applied, using the March 31st Rupee to Euro rate of 0.01052, requiring calculation during report processing to resolve the opportunity to 10,520 Euros. Finally, an opportunity report on March 31st in Euros again uses the March 31st conversion rate for Euros.
The following figure describes an example of user preferred currency using advanced currency management.

**Example of User Preferred Currency using Advanced Currency Management:**

User updates and saves or closes record on January 31st

User runs opportunity report on March 31st

Opportunity report on March 31st shows all opportunities in EUR

---

**Why do I see amounts of zero in analyses?**

The currency exchange rates might not be set up correctly. For example, you choose EUR as your preferred currency in general preferences, and your corporate currency is USD. Amounts in analyses are displayed in EUR after conversion from USD, based on the current exchange rate. But if the exchange rate between EUR and USD isn't set up, or if the conversion fails for any reason, then the amounts show as zero.

---

**Create the Treasury Conversion Rate Type**

You must create a conversion rate type with the name ‘Treasury’ to generate reports with constant dollar related data. You can create this conversion rate from the Currency Rates Manager page.

Based on your access permissions, you can access this page either from the

- Period Close work area; or
- Functional Setup Manager, with tasks like the Manage Conversion Rate Types and Manage Daily Rates.

For example, to create the Treasury conversion rate from the Period Close work area:

1. In the Navigator, click Period Close.
2. In the Period Close work area, from the Tasks panel, select Manage Currency Rates.
3. From the Actions menu, select Add Row and create the new conversion rate type with the name Treasury.
4. On the Daily Rates tab, enter the currency rates for the Treasury conversion rate type.

**Note:** You must set up the constant dollar conversion rate from every currency to CD for all dates in a year. During currency conversion, the "From" currency is taken from the transaction and the "To" Currency will always be CD for constant dollar.

---

**Configure Business Intelligence Publisher**

**Overview of Report Delivery Servers Management**

Oracle Business Intelligence Publisher, the report generation and delivery engine, requires configuration and tuning to deliver reports to users.

Report requests are received by Publisher from:

- Oracle Enterprise Scheduler
- The Reports and Analytics work area and panel tab
- Application pages

Requests submitted through Oracle Enterprise Scheduler are processed by the Oracle BI Publisher scheduler. Requests submitted through the Reports and Analytics work area or panel tab can be either real-time online requests or scheduled requests. Requests submitted through an application may call Oracle Enterprise Scheduler or may return report request results directly back to the application page.

Oracle BI Publisher is configured to accept requests from Oracle Applications Cloud. However, before you can deliver report documents to their destinations, you must define the delivery servers in Oracle BI Publisher. Use the Oracle BI Publisher Administration page to define your delivery servers.

Once delivery servers are defined, you can further configure the number of report processor and delivery threads to best handle your processing and delivery requirements. In addition, you can configure report properties for the delivery servers or at the report level to tune performance of your reports. To diagnose report processing issues, BI Publisher provides a set of scheduler diagnostics.

**Navigate to the BI Publisher Administration Page**

You use the Oracle BI Publisher Administration Page to perform most tasks related to report delivery and performance. Use the Oracle BI Publisher Administration page to:

- Configure delivery servers
- Manage report and delivery processors
- View scheduler diagnostics
- Set system properties and report runtime configuration properties

Request the Oracle Applications Cloud security administrator to assign the BI Platform Administrator duty role (BI stripe) to the person responsible for administering BI analyses, dashboards, and BI Publisher reports. Administration
tasks include security permissions for objects, organizing objects into folders, accessing log files, and several other tasks.

Navigating to the Administration Page

To navigate to the Oracle BI Publisher Administration page:

1. Click **Tools > Reports and Analytics** in the Navigator.
2. In the Reports and Analytics work area, click **Browse Catalog**.
3. In the Catalog page, click **Administration**, then click **Manage BI Publisher**.

Configure Report Delivery Servers

Set up the report delivery servers to support printing.

Configuring Servers

To configure delivery servers:

1. From the BI Publisher Administration page, click **Delivery Configuration**.
2. Enter values in the Delivery Configuration Options tab to set general properties for email deliveries and notifications.
3. To configure a delivery server, click the appropriate tab.

Configure Printers

You can set a default printer for your account and restrict access to a printer by roles.

Set a Default Printer

You can set a default printer for your account so that when you schedule a job with the destination as Printer, this printer is selected. However, you can select another printer assigned to your role.

To set a default printer:

1. Navigate to BI Publisher using the https://<FA_instance_host>/xmlpserver URL.
2. Click your user name and select **My Account**.
3. In the General tab, select a printer from the list and click **OK**.

Restrict Access to a Printer by Roles

By default, the access to a printer is set to Public, which makes it available to all users. But you can configure which roles can access a printer.

1. Navigate to the Administration page.
2. In the Delivery section, select **Printer**.
3. In the Printer tab, add a new printer or select an existing one.
4. In the Access Control section, deselect **Public**.
5. Select one or more roles you want to provide access to the printer, and click **Move** to add them to the Allowed Roles.
6. Click **Apply**.
Overview of Report and Delivery Processors

When Oracle Enterprise Scheduler initiates a job, it is picked up by the BI Publisher scheduler queue.

- **Job Processor**: Listens for requests from the scheduler queue. When the job information is received, the job processor executes the data model (and splits the data for bursting jobs), stores the data in the shared temporary folder, and sends the report metadata to the report queue.

- **Report Processor**: Listens for requests from the report queue. When the report information is received, the report processor generates the report documents, stores it in the shared temporary folder and puts the delivery information in the delivery queue.

- **Delivery Processor**: Listens to the delivery queue and handles the delivery of reports for its channel. The delivery processors are:
  - Email Processor
  - File Processor
  - FTP Processor
  - Print Processor
  - WebDAV Processor
  - Fax Processor

Manage Report Processing and Delivery Server Load

Manage the processors in the BI Publisher Scheduler Configuration page.

Managing Processing and Server Load

By default, each processor is enabled and the thread count for each is set to five. For each managed server that is running in the BI cluster, a table for that instance's processors is displayed. Use the table to enable or disable processors for the instance and configure the thread counts.

To configure processor threads:

1. From the BI Publisher Administration page, click **Scheduler Configuration**.
2. In the Cluster Instances region of the Scheduler Configuration page, enter the Number Threads value in the processor configuration table.
3. All processors are automatically set to use the number of threads defined in the Threads Per JMS Processor value of the JMS Configuration region of the page. Enter a value in the Number Threads column to change the value from this default.

After performing the scale-out procedure, configure the processor threads for each cluster instance using the same steps.
Diagnose Report Processing Issues

The Scheduler Diagnostics page provides the runtime status of the scheduler. Among others, it provides status of its JMS configuration, JMS queues, cluster instances, scheduler Database, and Oracle Enterprise Scheduler.

Diagnosing Issues

To access the Scheduler Diagnostics page:

1. Navigate to the Oracle Business Intelligence Publisher Administration page.
2. In the System Maintenance group, click Scheduler Diagnostics.

Configure System Properties for Reports

Use the Oracle BI Publisher Runtime Configuration page to set the system-level runtime properties for reports.

Configure Reporting Properties

To access the Runtime Configuration page:

1. Navigate to the Oracle Business Intelligence Publisher Administration page.
2. In the Runtime Configuration group, click Properties.

FTP and SFTP Delivery Retry Property

By default, if FTP or SFTP delivery fails, another attempt is made to deliver the file to the failed destination 10 seconds later. When you set the Enable FTP/SFTP delivery retry property to False, no retry attempt is made. This setting affects all of the FTP and SFTP delivery requests, and can't be configured for individual servers.

XPT Template Properties

Configure XPT templates by setting the properties described in the table.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>XPT Scalable Mode</td>
<td>When you set this property to true, scheduled reports that use the XPT template and include a large amount of data run without memory issues. The first 100,000 rows of data in the report are stored in memory and the remaining rows are stored in the file system. For reports that contain smaller amount of data, you can set this property to false. So, scheduled reports that use the XPT template are processed in-memory.</td>
<td>true</td>
</tr>
<tr>
<td>Enable Asynchronous Mode for Interactive Output</td>
<td>When you set this property to true, interactive reports that use the XPT template are processed asynchronously.</td>
<td>true</td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>template make asynchronous calls to Oracle WebLogic Server. When you set this property to false, interactive reports that use the XPT template make synchronous calls to Oracle WebLogic Server. Oracle WebLogic Server limits the number of synchronous calls. Any calls that are stuck expire in 600 seconds.</td>
<td></td>
</tr>
</tbody>
</table>

**Overview of Memory Guard Settings**

Memory Guard settings for Oracle BI Publisher have default settings optimized for performance.

**Reviewing Memory Guard Settings**

To Review Memory Guard Settings:

1. Click **Properties**.
2. Click **Manage BI Publisher**.
3. In the Runtime Configuration, click **Properties**.
4. The Memory Guard settings set thresholds for report size and runtimes.

**Use a Dedicated Business Intelligence Publisher Cluster for Critical Jobs**

For some time-sensitive reports, including for example paycheck and invoice generation, you can use a dedicated Business Intelligence Publisher cluster by setting the report’s priority as critical, ensuring that reports are run during critical time windows.

Critical jobs are assigned to a dedicated cluster. To set a report as critical:

1. Open the report.
2. Click **Properties**.
3. In the Advanced Report Properties in the General tab, select **Critical** in the Job Priority list.

**Determining Which Reports Are Prioritized as Critical**

To review which reports have been marked as critical, navigate to Report Job Histories, where critical jobs are highlighted.
Download Armored PGP Public Key Files

To support encrypted communication channel from the BI Publisher Server to an FTP site, you download a Pretty Good Privacy (PGP) public key file in ASCII armor format and configure your FTP server to use PGP encrypted files in that format.

Download PGP Public File

Download PGP keys in the BI Publisher Administration page.

To download a PGP key in armored format:

1. Navigate to the BI Publisher Administration page.
2. In the Security Center section, click the PGP Keys link to open the PGP Keys page.
3. In the PGP Keys section, click the Download BI Publisher Key [name] (ASCII armored) Download icon.
4. In the Opening bipublisher@oracle.com.key dialog box, click OK. Enter a name for the key or accept the default in the Save dialog box and click OK.

Upload and Apply PGP Keys for PGP Encryption for FTP Delivery

To secure report delivery through the FTP/SFTP channel, you can encrypt the report using PGP Encryption.

Upload PGP Keys

You upload, test, and delete PGP keys in the BI Publisher Administration page.

To upload PGP keys:

1. Navigate to the BI Publisher Administration page.
2. In the Security Center section, click the PGP Keys link to open the PGP Keys page.
3. In the PGP Keys section, click Browse and select the PGP key file in the Open dialog box.
4. Click OK.
5. Click Upload. After the file is uploaded, it is imported into the keystore and its details are visible in the PGP Keys table. If a key with the same ID is imported again, the file is overwritten.
6. Click the Download icon of the key in the Encrypted Test Output column of the PGP Keys table to download and decrypt a test output file using the secret key of the imported public key. Successful decryption confirms the encryption is working for your keys.

Delete a PGP Key

To delete an imported public key, click the Delete icon.

Apply PGP Encryption to FTP Delivery Channel

To create an FTP channel:

1. Navigate to the BI Publisher Administration page.
2. In the Delivery section, click the FTP link to open the FTP page.
3. Add a new FTP Server, using the user name and the password and private key password set when you created the PGP key. The Filter Command field is read-only and is updated automatically when you select a PGP key.
4. Click Test Connection.
5. Select the PGP Key ID of the key you uploaded from the list.
6. If you want PGP encrypted output in ASCII armored format on the destination FTP server, select the **ASCII Armored Output** check box. The Filter Command is updated with a `-a` option.

7. Select the **true** check box for Sign Output to sign the encrypted document. If you select this check box, a `-s` parameter is added to the existing filter command.

8. Test the connection again to confirm that an encrypted test file is sent to the remote directory. The FTP delivery channel can now be used in a scheduled job.

### Configure the Email Addresses for Notifications

Use the Delivery Configuration Options page to set e-mail addresses for notifications from BI Publisher.

To configure the email address for delivery notification:

1. Log in as an administrator.
2. In the BI Publisher home page, click **Administration**, and then click the **Delivery Configuration** tab.
3. Enter the email addresses in the Email From Address and Delivery Notification Email From Address fields.
4. Enter the email subject text in the following fields:
   - Success Notification Subject
   - Warning Notification Subject
   - Failure Notification Subject
   - Skipped Notification Subject

### Upload and Manage Configuration-Specific Files

Use Upload Center to upload and manage the configuration-specific files for font, digital signature, ICC profile, SSH private key, and SSL certificate.

To upload and manage configuration-specific files:

1. From the BI Publisher Administration page, click **Upload Center**.
2. Click **Browse** and select the file you want to upload.
3. Select the configuration file type.

   **Note:** A digital signature file should have a `.pfx` or `.p12` extension. Signature files with other exceptions fail to upload due to incorrect extension.

4. If you want to overwrite an existing file with the new file, select **Overwrite**.
5. Click **Upload**.
6. To manage the uploaded files, use the Filter By Type field to filter the files in the table.

### Upload Fonts

If you want to use non-standard fonts, you can upload them using either the Upload Center tab on the System Maintenance page, or the Font Mappings tab on the Runtime Configuration page. Fonts uploaded through either are listed in the other.
You can map a font for a report or for the instance. If you map fonts at the report level before you map fonts at the instance level, and if the server level font map isn't applied to a report, edit and correct the report properties.

Set Up and Configure Auditing and Monitoring

BI Publisher logs statistics about user activity using that can be reported on in reports. An administrator can set the level of auditing and monitoring or turn them off.

Logged User Events

Important report publishing events are logged in the audit database, including the following. You can control the level of auditing.

- Tracks the start and end time of request events for reports (normal and scheduled).
- Tracks the relationship between requested start time, report execution events (data processing, bursting, rendering, and delivery), and request end events for report requests.

Access Audit Records

To access audit records:

1. Configure the AuditDB data source.
   a. Click Administration.
   b. Click the JNDI Connection.
   c. Click Add Data Source, and enter:
      - Data Source Name: AuditDB
      - JNDI Name: jdbc/AuditViewDataSource
   d. Click Test Connection to confirm the connection.
   e. Click Apply.
2. Create a data model.
   a. In the Home page, click New and select Data Model.
   b. Click New Data Set and select SQL Query.
   c. In the Edit Data Set dialog box, select AuditDB in the Data Source list.
   d. Accept the default, Standard SQL, in the Type of SQL list.
   e. Enter the following SQL statement:
      
      ```sql
      SELECT IAU_TSTZORIGINATING, IAU_INITIATOR, IAU_EVENTTYPE, IAU_Resource from BIPUBLISHER_V
      ORDER BY IAU_TSTZORIGINATING DESC
      ```
   f. Click OK.
   g. Click Save to save the data model.
   h. Click View Data.
      i. In the Data tab, click View.
   j. Click Save As Sample Data.
   k. Click Save to save the data model.
   l. Click Create Report.
3. Create a simple report with table layout.
Configure Auditing and Monitoring Levels
Administrators can configure auditing and monitoring in the BI Publisher Server Configuration page.

To manage auditing and monitoring:

1. Click the Administration link.
2. In System Maintenance, click Server Configuration.
3. In the Monitor and Audit section, select the appropriate option:
   - To enable both auditing and monitoring, select Enable Monitor and Audit, and select Medium from the Audit Level list.
   - To disable both auditing and monitoring, deselect Enable Monitor and Audit.
   - To disable auditing and enable monitoring, select Enable Monitor and Audit, and select None from the Audit Level list.
4. Click Apply.

Configure Deep Links

Register Business Intelligence to Support Deep Linking

Deep linking lets you to navigate from an analysis on the interface pages to specific attributes and objects in your work areas so that you can work with them directly. What does that mean? It means that if you are looking at an analysis on leads, for example, you can click a record on the analytic and go edit the lead record on the edit object page. To support deep links, use the Setup and Maintenance work area to register the Business Intelligence Server as a third-party application.

Registering Business Intelligence Server as a Third-Party Application

To register the BI Server:

1. Use the Manage Third Party Applications task.
2. Click Create.
3. Enter AnalyticsApp as the application name.
4. Enter the full URL for the BI Server (for example: http://host:port/analytics/saw.dll).
5. Enter Analytics Server as the Partner Name.
6. Click Save and Close.

Related Topics
- Register a Third-Party Application

Create Deep Links

Create deep links in analyses to navigate from analytics to specific attributes and objects in your transactional pages to work with them directly.

1. In the Reports and Analytics work area, click Browse Catalog.
2. Create or edit an analysis. Use a subject area that includes the attribute you want to link to in the transactional pages, and ensure that you include the object ID.

3. On the Criteria tab, click the **Options** icon for the attribute column on which you need a deep link and select **Column Properties**.

4. Open the Interaction tab in the Column Properties dialog box.

5. In the Primary Interaction list in the Value section, select **Action Links** to display the Action Links table.

6. Select the **Do not display in a pop-up if only one action link is available at runtime** option.

7. Click **Add Action Link**.

8. In the New Action Link dialog box, enter the link text for the navigation.

9. Click the **Create New Action** icon and select **Navigate to a Web Page**.

10. In the Create New Action dialog box, enter the URL to navigate to, which references parameters you define in the prompt. For shared analyses: //</hostname>/fscmUI/faces/deeplink?objType=@{1}&objKey=<object ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26path=/shared/Custom/<folder>/@{6}

For personal analyses stored in My Folders: //</hostname>/fscmUI/faces/deeplink?objType=@{1}&objKey=<object ID>=@{2}&action=@{3}&returnApp=AnalyticsApp&returnAppParams=PortalGo%26path=/users/@{5}/@{6}

11. Click **Define Parameters** to add corresponding parameters for the URL.

12. In the Define Parameters section, click **Add Parameter** to add the following mandatory parameters:

<table>
<thead>
<tr>
<th>Name</th>
<th>Prompt</th>
<th>Type of Value</th>
<th>Value</th>
<th>Fixed</th>
<th>Hidden</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object Type</td>
<td>Value</td>
<td>&lt;Object Type&gt;</td>
<td>Selected</td>
<td>Selected</td>
<td>Used for shared and personal analyses.</td>
</tr>
<tr>
<td>2</td>
<td>&lt;Prompt Name&gt;</td>
<td>Column Value</td>
<td>Column Name in &quot;&lt;table. name&gt;&quot;.&quot;&lt;column. name&gt;&quot; format</td>
<td>Selected</td>
<td>Selected</td>
<td>Used for shared and personal analyses.</td>
</tr>
<tr>
<td>3</td>
<td>Action</td>
<td>Value</td>
<td>edit</td>
<td>Selected</td>
<td>Selected</td>
<td>Used for shared and personal analyses.</td>
</tr>
<tr>
<td>4</td>
<td>returnApp</td>
<td>Value</td>
<td>AnalyticsApp</td>
<td>Selected</td>
<td>Selected</td>
<td>Used for shared and personal analyses.</td>
</tr>
<tr>
<td>5</td>
<td>Logged in User</td>
<td>Session Variable</td>
<td>USER</td>
<td>Selected</td>
<td>Selected</td>
<td>Session variable parameter used for personal analysis permissions.</td>
</tr>
</tbody>
</table>
### Chapter 2: Setup and Configuration

#### Related Topics
- Manage Analytics with Advanced Features

### Configure Deep Links in Oracle Product Lifecycle Management Cloud

For products that come under Oracle Product Lifecycle Management (PLM) Cloud, the URLs that are supplied for deep links in the **Create New Action** dialog box of Oracle Business Intelligence Enterprise Edition (OBIEE) use the following format: Base URL + Generic Part of Link + Object-Specific Arguments.

The URLs contain these elements:
- An application-specific base URL, such as `https://demo.oracleserver.com/`
- A generic part, which is the same for all links: `fscmUI/faces/deeplink?`
- Object-specific arguments, which are provided in the `objType&action&objKey` format.

An example of a complete, case-sensitive URL is as follows: `https://demo.oracleserver.com/fscmUI/faces/deeplink?objType=CHANGES&action=EDIT&objKey=changeObjectId=<CHANGE_ID>`

The following table lists the objects that are supported for deep links in the Innovation to Commercialization lifecycle process of Oracle PLM Cloud. For each object, the corresponding arguments are provided.

<table>
<thead>
<tr>
<th>Object</th>
<th>Object-Specific Argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td><code>objType=CHANGES&amp;action=EDIT&amp;objKey=changeObjectId=&lt;CHANGE_ID&gt;</code></td>
</tr>
<tr>
<td>Concept</td>
<td><code>objType=CONCEPTS&amp;action=EDIT&amp;objKey=conceptId=&lt;CONCEPT_ID&gt;</code></td>
</tr>
<tr>
<td>Idea</td>
<td><code>objType=IDEAS&amp;action=EDIT&amp;objKey=ideaId=&lt;IDEA_ID&gt;</code></td>
</tr>
<tr>
<td>Object</td>
<td>Object-Specific Argument</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Item (opens in Oracle Product Development Cloud)</td>
<td><strong>ObjType=ITEMS&amp;action=EDIT&amp;objKey=itemId%3D&lt;INVENTORY_ITEM_ID&gt;%3BorgId%3D&lt;ORGANIZATION_ID&gt;</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The object-specific argument should be manually entered as provided in the URL field after the parameters are defined. A placeholder should be used in place of the INVENTORY_ITEM_ID parameter value in the format required by OBIEE. The orgId parameter must be explicitly set to the ID of your organization.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td><strong>ObjType=MFRS&amp;action=EDIT&amp;objKey=partyId=&lt;TRADING_PARTNER_ID&gt;</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The link works for only those manufacturers that are created in Oracle Product Development Cloud.</td>
</tr>
<tr>
<td>Manufacturer Part</td>
<td><strong>ObjType=MPN&amp;action=EDIT&amp;objKey=tpItemId=&lt;TP_ITEM_ID&gt;</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The link works for only those manufacturer parts that are created in Oracle Product Development Cloud.</td>
</tr>
<tr>
<td>New Item Request</td>
<td><strong>ObjType=NIRS&amp;action=EDIT&amp;objKey=changeId%3D&lt;NEWITEMREQUEST_ID&gt;%3Bmode%3DviewOrEdit</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The object-specific argument should be manually entered as provided in the URL field after the parameters are defined. A placeholder should be used in place of the NEWITEMREQUEST_ID parameter value in the format required by OBIEE.</td>
</tr>
<tr>
<td>Portfolio</td>
<td><strong>ObjType=PORTFOLIOS&amp;action=EDIT&amp;objKey=bvForPortfolioId=&lt;PORTFOLIO_ID&gt;</strong></td>
</tr>
<tr>
<td>Proposal</td>
<td><strong>ObjType=PROPOSALS&amp;action=EDIT&amp;objKey=productProposalId=&lt;PROPOSAL_ID&gt;</strong></td>
</tr>
<tr>
<td>Quality Action</td>
<td><strong>ObjType=ACTIONS&amp;action=EDIT&amp;objKey=actionId=&lt;ACTION_ID&gt;</strong></td>
</tr>
<tr>
<td>Quality Issue</td>
<td><strong>ObjType=ISSUES&amp;action=EDIT&amp;objKey=issuelId=&lt;ISSUE_ID&gt;</strong></td>
</tr>
<tr>
<td>Requirement Specification</td>
<td><strong>ObjType=REQUIREMENTS&amp;action=EDIT&amp;objKey=requirementId=&lt;REQUIREMENT_ID&gt;</strong></td>
</tr>
</tbody>
</table>
In the preceding table, the parts of the object-specific arguments that are in boldface must be manually inserted into the links in the **URL** field of the **Create New Action** dialog box after the parameters are defined. The angle brackets and the enclosed text are placeholders for the ID columns that must be manually specified in the **Define Parameters** group of the dialog box. The resulting link in the **URL** field, including the placeholders that are dynamically inserted for parameter values by OBIEE, should be similar to the following: https://demo.oracleserver.com/fscmUI/faces/deeplink?objType=@{1}&action=@{2}&objKey=changeObjectId=@{3}

**Note:** Ensure that the values in the ID columns in your analyses do not have decimal values or commas. Deep links that use ID columns with decimal values or commas do not work for Oracle PLM Cloud.

## Set Up the Delivery Channel

### Set Up the Delivery Channel and Enable Encryption

BI Publisher supports Oracle WebCenter Content as the recommend delivery channel for delivering reports for distribution. You can use the provisioned connection to deliver files from BI Publisher to WebCenter Content, or configure a custom connection to deliver Pretty Good Privacy (PGP) encrypted files from BI Publisher.

**Using the Default Connection**

By default, a provisioned WebCenter Content connection, FA_UCM_Provisioned, uses a provisioned FUSION_APPS_OBIA_BIEE_APPID user to connect to WebCenter Content with security groups and accounts to support the most common use cases.

**Creating a Custom Connection**

If you have specific requirement to access WebCenter Content using user credentials other than FUSION_APPS_OBIA_BIEE_APPID, or if you want to use PGP key encryption, you can add a custom connection.

When you create a custom connection for WebCenter Content, it must use the same Uniform Resource Identifier (URI) as the provisioned connection, but should have its own user name and password.

To create a custom connection:

1. In the BI Publisher Administration page, navigate to the Content Server tab in the Delivery section, and click **Add Server**.
2. Enter the same URI used by the provisioned FA_UCM_Provisioned WebCenter Content server.
3. Enter the server name, URI, user name, and password.
4. Leave Enable Custom Metadata deselected. Custom metadata is not used.
5. Click **Test Connection** to ensure that you can connect.
6. Click **Apply**.

**Configuring File Encryption**

You can use PGP encryption to secure the file delivery.

To use PGP encryption:

1. Upload the PGP public keys to import the PGP keys of WebCenter Content.
   a. Navigate to the Security Center section in the BI Publisher Administration page.
   b. Click **PGP Keys** to open the PGP Keys page.
   c. In the PGP Keys section, click **Browse** and select the PGP key file in the Open dialog box.
d. Click **Upload**. The uploaded file is imported into the keystore and its details are visible in the PGP Keys table. If a key with the same ID is imported again, the file is overwritten.

e. Click **Download** for the key in the Encrypted Test Output column of the PGP Keys table to download and decrypt a test output file using the secret key of the imported public key. Successful decryption confirms the encryption is working for your keys.

2. Enable delivery of PGP encrypted files in a custom connection to WebCenter Content.
   a. Navigate to the Delivery section and the Content Server page.
   b. Select the custom content server connection you want to configure.
   c. Select the imported key by its ID from the PGP Keys list and verify that the GPG command is populated in the Filter Command.
   d. Click **Apply**.

### Deliver Content

Use a scheduled job to deliver content and documents.

### Scheduling a Job to Deliver Content

To schedule a job to deliver documents:

1. In BI Publisher, click **Create** and select **Report Job**.
2. In Schedule Report Job, on the General tab, click **search** for the Report field.
3. In the Open dialog box, navigate to and select the report, and then click **Open**.
4. In Schedule Report Job, in the Frequency list on the Schedule tab, select the option to use for this report.
5. (Optional) In Schedule Report Job, on the Output tab, select **Compress output prior to delivery** to compress the output for all formats except HTML. When the output is delivered, it's compressed except for zipped PDF format in all delivery channels and HTML Output format in the Email delivery channel. If the delivery destination is Email, reports are attached to emails in `<Name>_<Output Format>.zip` format.
6. In Schedule Report Job, on the Output tab, choose **Content Server** in the Destination Type list.
7. Click **Add Destination**.
8. Select the server from the Server list.
9. Select the WebCenter Content security group to assign to the report.
10. (Optional) Select an account within the Security Group to assign to the report.
11. (Optional) Select the Folder Path to deliver files to an existing folder in the content server.
12. (Optional) Enter a value for Author. If you don't enter an author, your user name is used for the Author metadata in WebCenter Content.
13. (Optional) Type a Title for the report. If you don't enter a title, the layout name is used for the title.
14. Enter the file name to assign to the delivered document on the remote server, for example, `myreport.pdf`.
15. Ensure that you don't include files with the same name in one folder. The File Name field is used as the Native File Name in WebCenter Content. If you don't supply a file name value, the Output name is used.
16. (Optional) Type a description to include with the document in WebCenter Content.
17. Deselect **Include Custom Metadata**.
18. Click **Submit**.
19. In the Submit dialog box, type a name in the Report Job Name field, and click **OK**.
20. Click **Home** and navigate to the Report Job History page to verify the report delivery status.

### Defining a Bursting Query to Deliver to Deliver Content

Bursting is a process of splitting data into blocks, generating documents for each block, and delivering the documents to one or more destinations. The data for the report is generated by executing a query once and then splitting the data...
based on a key value. For each data block, a separate document is generated and delivered. The bursting query is a SQL query that you define to provide the required information to format and deliver the report.

To deliver reports to WebCenter Content, define the bursting job with WCC as the delivery channel, and configure the parameter values as shown in the table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEL_CHANNEL</td>
<td>Delivery channel. Specify <strong>WCC</strong> for WebCenter Content.</td>
</tr>
<tr>
<td>Parameter1</td>
<td>Server name</td>
</tr>
<tr>
<td>Parameter2</td>
<td>Security group</td>
</tr>
<tr>
<td>Parameter3</td>
<td>Author of the file</td>
</tr>
<tr>
<td>Parameter4</td>
<td>Account (Optional)</td>
</tr>
<tr>
<td>Parameter5</td>
<td>Title</td>
</tr>
<tr>
<td>Parameter6</td>
<td>Output file name</td>
</tr>
<tr>
<td>Parameter7</td>
<td>Comments (Optional)</td>
</tr>
<tr>
<td>Parameter8</td>
<td>Content ID (Optional) If you specify the ID, it must be unique. If you don't specify the ID, a unique ID is generated.</td>
</tr>
<tr>
<td>Parameter9</td>
<td>Custom metadata, set as true or false. Specify <strong>false</strong>.</td>
</tr>
<tr>
<td>Parameter10</td>
<td>Folder Path</td>
</tr>
</tbody>
</table>

**Note:** Ensure that you don't include files with the same name in one folder and that the Content ID is unique.

The following is a sample query for bursting reports:

```sql
select distinct
    product_status as "KEY", -- Split Key from data model SQL
'BurstTemp' TEMPLATE, -- Report template name
'en-US' LOCALE,
'PDF' OUTPUT_FORMAT, -- Output type
'WCC' DEL_CHANNEL, -- To send to content server
'Custom_UCM' PARAMETER1, -- Content server name
'CRMStage' PARAMETER2, -- Security group
'hcm.user' PARAMETER3, -- Author of the file
'PARAMETER4', -- Account (Optional)
'Test_Burst' PARAMETER5, -- Title
```
Chunk Data for Large XML Reports

To support distributed processing for large and long-running reports, you can enable chunking of report data. If you enable data chunking, the data model pre-processor uses a designated split key to split large amounts of XML data into several chunks of data of manageable size. The layout processor outputs individual XML data chunks and merges them to generate a consolidated final report output.

Limitations

Before enabling chunking, you should understand its limitations and recommended uses. Data chunking:

- Is best suited for listing reports. The most straightforward application is a listing report with a table with no cross-referencing.
- Supports sorting, grouping, aggregation, and cross-referencing operations only within the individual chunked output. The merged output doesn’t support these data operations.
- Supports page numbering, running totals, and other functions only within the individual chunked output, and each is reset with each chunked output.
- Supports only RTF, XPT, and eText output formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTF</td>
<td>Each chunked output starts from a new page.</td>
</tr>
<tr>
<td>XLSX</td>
<td>Each chunked output is on a separate sheet.</td>
</tr>
<tr>
<td>E-Text</td>
<td>Each chunked output is appended while generating final output.</td>
</tr>
</tbody>
</table>

- Doesn’t support the multiple output formats. If you select chunking during scheduling, multiple outputs aren’t allowed.
- Isn’t supported for online reports.

Enable Chunking

You enable chunking for an instance, set chunking and a split key for a data model, and then set chunking and a chunk size for a report.

To enable chunking for an instance and set a default chunking size:

1. From the BI Publisher Administration page, click **Properties**.
2. Select **True** for Enable Data Chunking. The default is False.
3. Enter a chunk size. The default is 300MB, and valid chunk sizes are 100MB to 300MB.
4. Click **Apply**.
To enable chunking for a data model:

1. In the Data Model Editor, select **Chunking**.
2. Select **Enable Chunking**.
3. Select an attribute in the **Split By** list.
4. Click **Save**.

Once you have enabled chunking for your reports, specify chunking when you schedule the report job.

1. In Schedule Report Job, on the General tab, select **Use XML Data Chunking**.
2. Specify an output. Chunked jobs can have only one output.
3. Click **Submit**.

### Consolidated Output with Attachments from a Bursting Job

A bursting job splits data, generates reports, and delivers the reports to one or more destinations. When you create a bursting job, you have an option to create a consolidated output. The consolidated output combines all the reports from a bursting job in a single consolidated PDF file. If the bursting output format is zipped PDF (PDFZ), then a consolidated PDFZ output is created. If the reports of the bursting job include attachments, then the consolidated output also includes the attachments of all the reports.

When the consolidated output is a PDFZ file, it includes a docindex.xml file that provides an index of all PDF outputs and attachments in the consolidated PDFZ file.

### Limitation

The PDFZ output format isn’t suitable if you want to:

- Enable password protection for the compressed PDF output.
- Use the PDF splitting feature in the RTF template. The index.xml and index.html files in the consolidated output don’t have the corresponding catalog index if you use the splitting feature in the RTF template.
- Generate individual files from the consolidated PDFZ file.
- Retain the page numbers of all the reports and attachments in the consolidated PDFZ file. The page numbers change because the reports and attachments are merged in the PDFZ file.
- Include angular brackets (<> or special characters (such as &apos; and &apos;) in the index variables. The XML parser doesn’t support these characters.

**Note:** It is recommended that you don’t create a single consolidated PDF output of extremely large size. You must assess the size of PDF attachments, individual outputs through bursting, and count of associated jobs to avoid creating extremely large consolidated output file.

### Embed Analyses and Dashboards

### Whitelist Safe Domains

You whitelist safe domains to approve access to specific content. For security reasons, external content can’t be added to reports and reports can’t be embedded in other applications unless it’s safe to do so. Only administrators can add safe domains to the white list.
Only authorized users may access the content. Except in cases where Single Sign On (SSO) is enabled, users are prompted to sign in when they access content on safe domains. After you have added a safe domain to the white list, users need to sign out and sign back in to access content from that source.

1. Click Navigator > Reports and Analytics.
2. Click Browse Catalog.
3. Click the Administration link on the BI Home page.
4. Click the Manage Safe Domains link.
5. To allow users to embed their analyses in content located on other domains, enter the name of the safe domain as well as the port. Here are a few formats you can use for port names:
   - www.example.com:<port number>
   - *.example.com:<port number>
   - https:
6. Select the types of resources you want to allow and block any resource types you think aren't safe. For example, to allow embedding, select Embedding.

### Embed Your Content in Other Applications

You can embed your reports in other non-Oracle applications and portals. This is a good way to share content and data among multiple systems. When other users click on embedded content, if you don't have single sign-on, they might have to sign in again to see the content.

Before you can embed a report in other applications or portals, your administrator must add the URL for the target applications or portal to the domain whitelist.

1. Obtain the URL of the analysis or dashboard you want to embed.
   a. Go to the catalog and open the analysis or dashboard.
   b. In the URL displayed in the browser’s address bar, delete "Portal", so that your URL resembles this example, then copy the URL.

<table>
<thead>
<tr>
<th>Content</th>
<th>Example URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyses</td>
<td><a href="http://example.com">http://example.com</a>:&lt;port number&gt;/ analytics/ sawdllGoAction prompt&amp;path=</td>
</tr>
<tr>
<td></td>
<td>%2Fshared%2F&lt;folder&gt;%20&lt;analysis name&gt;</td>
</tr>
</tbody>
</table>

2. Sign in to the target application or portal, then embed the content inside an iFrame and use the copied URL.
### Supply Chain Management Repository and Session Variables for Business Intelligence

The tables below show repository and session variables available for use in your analyses.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
<th>Usage</th>
<th>Offering</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT_DAY</td>
<td>Session Variable</td>
<td>Returns the value of Current Date.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Current Month in the YYYY/MM format</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_WEEK</td>
<td>Repository Variable</td>
<td>Returns the value of the current week in YYYY Weeknnn format.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Current Quarter in YYYY Q n format.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Current Year in the YYYY format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Next Month in the YYYY/MM format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_WEEK</td>
<td>Repository Variable</td>
<td>Returns the value of Next Week in the YYYY Weeknnn format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Next Calendar Quarter in the YYYY Q nn format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Next Year in the YYYY format.</td>
<td>All</td>
</tr>
<tr>
<td>PREVIOUS_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Month in the YYYY/MM format</td>
<td>All</td>
</tr>
</tbody>
</table>
### Variable Name | Type | Usage | Offering
--- | --- | --- | ---
PREVIOUS_WEEK | Repository Variable | Returns the value of Previous Week in the YYYY Week nn format. | All
PREVIOUS_QUARTER | Repository Variable | Returns the value of Previous Quarter in the YYYY Q nn format. | All

These variables are available for Supply Chain Management.

### Variable Name | Type | Usage | Offering
--- | --- | --- | ---
CURRENT_MONTH_END_DATE_REP_OTBI | Repository Variable | Returns the current Gregorian month end date. | Supply Chain Management
CURRENT_MONTH_START_DATE_REP_OTBI | Repository Variable | Returns the current Gregorian month start date. | Supply Chain Management
CURRENT_WEEK_END_DATE_REP_OTBI | Repository Variable | Returns the current Gregorian week end date. | Supply Chain Management
CURRENT_WEEK_START_DATE_REP_OTBI | Repository Variable | Returns current Gregorian week start date. | Supply Chain Management
CURRENT_YEAR_END_DATE_REP_OTBI | Repository Variable | Returns the current Gregorian year end date. | Supply Chain Management
CURRENT_YEAR_START_DATE_REP_OTBI | Repository Variable | Returns the current Gregorian year start date. | Supply Chain Management
Last_Quarter_Days_OTBI | Repository Variable | Returns the number of days from the beginning of the last calendar quarter to the current date. | Supply Chain Management
This_Month_Days_OTBI | Repository Variable | Returns the number of days since the beginning of the current calendar month. | Supply Chain Management
This_Quarter_Days_OTBI | Repository Variable | Returns the number of days since the beginning of the current calendar quarter. | Supply Chain Management
ToUOM | Session Variable | Gets the user report-level reporting unit of measure | Supply Chain Management
<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
<th>Usage</th>
<th>Offering</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(UOM), and passes it on to the UOM conversion calculation engine.</td>
<td></td>
</tr>
</tbody>
</table>
3 Subject Areas

How Data Is Structured for Analytics

The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses, and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note: You can also use the BI repository as a data source for reports.

Columns

This table describes the three types of columns available when you create or edit analyses.

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fact</td>
<td>Provides a measure of something, meaning that the values are numbers.</td>
<td>Total</td>
</tr>
<tr>
<td>Attribute</td>
<td>Represents a piece of information about a business object, with values that are dates, IDs, or text.</td>
<td>Start Date</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Attribute columns can be flexfield segments imported into the BI repository.</td>
<td></td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Holds data values that are organized in a hierarchical manner.</td>
<td>Time, with sublevels:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Year</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Quarter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Month</td>
</tr>
</tbody>
</table>

Subject Areas

When you create an analysis, you first select a subject area, which contains columns related to a specific business object or area. Then, open folders within the subject area to find the columns to include.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

- Fact folders:
  - Contain fact columns.
Subject Areas

- Are usually the last in a list of folders and are usually named after the subject area.

  - **Dimension folders:**
    - Contain attribute and hierarchical columns.
    - Are joined to the fact folder within a subject area.

      For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in the results. If you also add the Total fact, then your analysis includes only records with both a currency and a total amount. The more columns you add, the smaller the query set for your analysis.

    - Can be common folders, or common dimensions, that appear in more than one subject area.

      If your analysis has columns from multiple subject areas, then you:
      - Should include columns only from dimension folders that are common to all of those subject areas. At least one such column is required.
      - Must include one column from the fact folder in each of those subject areas.

**Related Topics**
- Overview of Analytics Creation and Modification
- Manage Analytics with Advanced Features
- Create and Edit Analyses Using a Wizard
- Modify Data Models

**SCM Subject Areas in Oracle Transactional Business Intelligence**

To create a real-time analysis using Oracle Transactional Business Intelligence, select the subject area from which information is to be included in the analysis. For example, to create an analysis of item information, select a Product Management subject area. Subject areas are based around a business object or fact.

**Oracle Transactional Business Intelligence is available for the following functional areas in SCM:**

- Product Management
- Costing
- Inventory
- Receiving
- Shipping
- Order Management
- Innovation Management
- Enterprise Contracts
- Manufacturing
- Maintenance
- Service Logistics
Oracle SCM Cloud
Creating and Administering Analytics and Reports for SCM

Chapter 3

Subject Areas

• Supplier Portal
• Supply Chain Financial Flows
• Quality

Some sample, predefined subject areas for SCM are:
• Product Management - Change Order Real Time
• Product Management - Trading Partner Item Real Time
• Costing - COGS and Gross Margin Real Time
• Costing - Inventory Valuation Real Time
• Inventory - Inventory Balance Real Time
• Inventory - Inventory Transactions Real Time
• Receiving - Interorganization Receipts Real Time
• Receiving - In-Transit Shipments Real Time
• Shipping - Real Time
• Order Management - Order Headers Real Time
• Innovation Management - Portfolio Cost Real Time
• Innovation Management - Portfolio Lifecycle Real Time
• Manufacturing - Actual Production Real Time
• Manufacturing - Material Usage Real Time
• Maintenance Management - Asset Real Time
• Maintenance Management - Material Usage Real Time
• Quality - Quality Inspection Results Real Time

Subject areas for transactional business intelligence always include the suffix Real Time. For a complete list of SCM-specific subject areas, see the Oracle Supply Chain Management Cloud Subject Areas for Transactional Business Intelligence in SCM guide.

Run Scheduled Process for Populating Subject Areas

You must run a scheduled process to define certain items for which you want reports and analyses for the subject areas like Product Management- Structures and Components Real Time and Product Management- Where Used Real Time. Based on the items you provide as input, a scheduled process automatically populates these subject areas.

Follow these steps to run a scheduled process for Product Management- Structures and Components Real Time:

1. In the Scheduled Process work area, search for Expand Structure for Business Intelligence and select it.
2. In the Parameters, enter the item numbers, separated by commas if there are multiple items.
3. Provide the unique master organization code for product development.
4. Submit the scheduled process and ensure it has run successfully.
5. Navigate to the Reports and Analytics work area and select Create Analysis.
6. Select the Product Management- Structures and Components Real Time subject area.

Tip: The folder Structure Quick Preview is a good place to start for your reports.
Follow these steps to run a scheduled process for Product Management-Where Used Real Time:

1. In the Scheduled Process work area, search for Item Where Used for Business Intelligence and select it.
2. In the Parameters, enter the item numbers, separated by commas if there are multiple items.
3. Provide the unique master organization code for product development.
4. Submit the scheduled process and ensure it has run successfully.
5. Navigate to the Reports and Analytics work area and select Create Analysis.
6. Select the Product Management- Where Used Real Time subject area.

| Tip: | The folder Where Used Quick Preview is a good place to start for your reports.

Fact Folders and Dimension Folders

Each subject area has one fact folder and a number of dimension folders. Fact folders contain attributes that can be measured, meaning that they are numeric values like past due fulfillment lines and item numbers. A special folder, called a degenerate dimension, is also associated with the fact folder. Each dimension folder is joined to the fact folder within a subject area. Fact folders are usually named after the subject area.

Related Topics

- Oracle Supply Chain Management Cloud Subject Areas for Transactional Business Intelligence in SCM
4 Flexfields

Overview of Flexfield Use in Analyses

Flexfields are extensible sets of placeholder fields associated with business objects which can be placed on application pages. You can use flexfields to extend business objects and meet your data management requirements without changing the data model or performing any database programming. To include flexfields you have used for extension for use in analyses, you must enable them for business intelligence.

Extension of analyses using flexfields is available for Oracle Enterprise Resource Planning Cloud and Oracle Human Capital Management Cloud.

Flexfield Types

The following types of flexfields are available and provide a means to modify application features without programming:

- Descriptive
- Extensible
- Key

Depending on the flexfield type, business intelligence enablement is performed differently and has different requirements. Once they are enabled for business intelligence, you can import any changes made to flexfields automatically using an import scheduled process.

Configure Key Flexfields for Transactional Business Intelligence

Enable Key Flexfields for Business Intelligence Reporting

To include flexfields in your analyses, you must enable them for Business Intelligence. Extensibility of analysis using flexfields is used for Enterprise Resource Planning and Human Capital Management. For Customer Relationship Management, the Extensibility Framework supports this.

To designate key flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
2. On the Manage Key Flexfields page, enter your search value in Key Flexfield Code.
3. Click Manage Structure Instances.
4. Enter your search value in Structure Instance Code.
5. Click Edit to display the Edit Key Flexfield Structure Instance dialog box.
6. Select the BI Enabled option, then click OK.
7. For each flexfield segment instance, repeat steps 5 through 6.
8. Click Save.
9. Populate the BI Object Name for each of the segment labels:
   a. Query the Key Flexfield Code in the Manage Key Flexfields window.
   b. From the Actions menu, select Manage Segment Labels.
   c. Populate the BI Object Name for each segment label to be mapped. The BI Object Name for the following qualified segment labels should not be modified:

<table>
<thead>
<tr>
<th>Segment Label Code</th>
<th>BI Object Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FA_COST_CTR</td>
<td>Dim - Cost Center</td>
</tr>
<tr>
<td>GL_BALANCING</td>
<td>Dim - Balancing Segment</td>
</tr>
<tr>
<td>GL_ACCOUNT</td>
<td>Dim - Natural Account Segment</td>
</tr>
</tbody>
</table>

Before you deploy a flexfield, you must access the Chart of Accounts Instance and assign the newly created segment label to the appropriate segment in the Chart of Accounts.

d. Click Deploy Flexfield.
e. Click Save and Close.

Related Topics
- Considerations for Enabling Key Flexfield Segments for Business Intelligence
- Update Existing Setup Data

Overview of Supported Key Flexfields

Key flexfields are used to store internally defined codes unique to a particular business, specifying part numbers, general ledger accounts, and other business entities.

<table>
<thead>
<tr>
<th>Product Area</th>
<th>Key Flexfield</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Assets</td>
<td>Category (CAT#)</td>
<td>Dim - Asset Category</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>Location (LOC#)</td>
<td>Dim - Asset Location</td>
</tr>
<tr>
<td>General Ledger</td>
<td>Accounting (GL#)</td>
<td>Dim - Balancing Segment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dim - Cost Center</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dim - Natural Account</td>
</tr>
<tr>
<td>Payroll</td>
<td>Costing</td>
<td>Dim - Costing Segments</td>
</tr>
</tbody>
</table>
### Map Non-Qualified Segments to BI Objects

To map non-qualified segments that must be mapped and used in analysis, create a new label and associate a BI object with the label. Associate this new segment label with the segment code.

To map non-qualified segments to BI objects:

1. In the Setup and Maintenance work area, go to the **Manage Key Flexfields** task.
2. On the Manage Key Flexfields page, search for the appropriate key flexfield code.
3. From the Actions menu, select **Manage Segment Labels**.
4. Click the **Add Row** icon.
5. Enter the details for the Segment Label Code, including name, description, and BI Object name. Enter the BI object names carefully and note whether there is a space between **Segment** and the number.

This table provides examples of Key Flexfields and associated BI object names.

<table>
<thead>
<tr>
<th>Key Flexfield</th>
<th>BI Object Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting (GL)</td>
<td>Dim - GL Segment1 through Dim - GL Segment10</td>
</tr>
<tr>
<td>Budgetary Control (XCC)</td>
<td>Dim - XCC Segment1 through Dim - XCC Segment10</td>
</tr>
<tr>
<td>Revenue Management (VRM)</td>
<td>Dim - VRM Segment 1 through Dim - VRM Segment 10</td>
</tr>
</tbody>
</table>

6. Complete the mapping by assigning unique segment labels to the key flexfields.

### Set Up the GL Accounting Flexfields

This topic describes the workflow for setting up Accounting key flexfields, but these steps also apply for other key flexfields.

- Understanding Accounting Key Flexfields
- Identifying Accounting Key Flexfields
• Assigning Unique Segment Labels
• Performing Column Flattening
• Designating GL Accounting Segment Instances as BI-Enabled
• Deploying Accounting Key Flexfields

Understanding Accounting Key Flexfields
The Accounting Key Flexfield is used to identify GL accounts.

A chart of accounts segment is a component of the accounting key flexfield. Each segment has a value set attached to it to provide formatting and validation of the set of values used with that segment. The combination of segments creates the account combination used for recording and analyzing financial transactions. You must set up your Chart of Accounts (COA) as part of implementing Oracle Applications Cloud.

Examples of segments that may be found in a chart of accounts structure include Company, Cost Center, Department, Division, Region, Account, Product, Program, and Location.

The Natural Account segment of the General Ledger Accounting Key Flexfield defines the account used in the account combination to record transactions.

The logical segment dimensions in the Oracle BI metadata are Dim - Cost Center, Dim - Balancing Segment, Dim - Natural Account Segment and all Dim - GL Segment dimensions. These dimension tables are populated from a Tree value object or from a Value Set value object. Which value is used depends on whether a tree was associated with the segment in the Oracle Applications Cloud setup:

• For each segment associated with trees, two value objects are generated (Tree and TreeCode) with the following naming structure:
  FscmTopModelAM.AccountBIAM.FLEX_TREE_VS_segmentlabel_VI &
  FscmTopModelAM.AccountBIAM.FLEX_TREECODE_VS_segmentlabel_VI

• For each segment without trees, one view object is generated with the following naming structure:
  FscmTopModelAM.AccountBIAM.FLEX_VS_XXX_VI

In addition to the segment dimension tables, the BI Extension process also extends Flex BI Flattened VO; FscmTopModelAM.AccountBIAM.FLEX_BI_Account_VI. This view object has a pair of columns for each segment; segmentlabel_ and segmentlabel_c.

For example, for your Cost Center segment which has the segment label FA_COST_CTR, there are two columns in this view object, named FA_COST_CTR_ and FA_COST_CTR_c.

Identifying Accounting Key Flexfield Segments
Identify and map segments of the chart of accounts.

For each Chart of Accounts (Accounting Key Flexfield) used to analyze Transactional Business Intelligence facts, identify the segments of the chart of accounts. Map them to the Transactional Business Intelligence GL Accounting Segment logical dimensions.

<table>
<thead>
<tr>
<th>Accounting Key Flexfield Segment</th>
<th>Segment Label</th>
<th>Transactional Business Intelligence GL Accounting Segment Logical Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balancing</td>
<td>GL_BALANCING</td>
<td>Dim - Balancing Segment</td>
</tr>
</tbody>
</table>

ORACLE
Assigning Unique Segment Labels
You must assign a unique segment label to the charts of accounts segments that are the balancing segments or the natural account segments. The segments must be also used for specific purposes.

For example, assign the Primary Balancing segment label to the segment used for your company or legal entities. That label provides a correct recording of intercompany transactions and company analysis. You can assign other segment labels when required.

To assign unique segment labels to charts of accounts segments:

1. In the Setup and Maintenance work area, go to the Manage Charts of Accounts task and then navigate to the Manage Chart of Accounts page.
2. In the Search section, enter the GL# for the Key Flexfield Code and click the Search button.
3. In the Search Results section, select Accounting Flexfield and click the Manage Structures button to navigate to Manage Key Flexfield Structures.
4. In the Search section, enter the chart of accounts code or the name for Structure Code or Name and click the Search button.
5. In the Search Results section, select the chart of accounts and click Edit to navigate to the Edit Key Flexfield Structure window.
6. Select the Enabled check box to code-enable the Structure code.
7. In the Segments section, select the applicable segments and click Edit to navigate to the Edit Key Flexfield Segment window.
8. Select the Enabled check box to enable the segments.
9. In the Segment Labels section, select the unique segment labels to equalize the segments across the charts of accounts. Click the shuffle to move the segments to the selected list.
10. Click Save and Close to return to the Edit Key Flexfield Structure window.
11. Click Done to return to the Manage Key Flexfields window.

Performing Column Flattening
Column flattening of trees is required in order for OTBI hierarchy analyses to be populated with correct data.

To flatten columns for account hierarchies:

1. In the Setup and Maintenance work area, go to the Manage Trees and Tree Versions task and navigate to the Manage Trees and Tree Versions window.
2. In the Search section, enter GL_ACCT_FLEX for the Tree Structure Code and the involved tree code or name, and click Search.
3. In the Search Results section, select the tree version you want to flatten. If the status of the Tree Version is Draft, to make the Tree Version active, select Actions, then Status, and then Active.

4. (Optional): After the tree version is specified, perform an audit on the Tree Version to ensure its integrity before launching the flattening job. Select Actions and then Audit. See the section on working with Trees in the Developer’s Guide.

5. Choose Column Flattening from the Actions menu.

6. Click the Online Flattening button to launch the flattening job immediately. Or, click the Schedule Flattening button to schedule the flattening job according to your requirements.

### Designating GL Accounting Segment Instances as BI-Enabled

Specify the applicable chart of accounts segment instances that are BI-enabled to make them available for use in Transactional Business Intelligence.

To specify the chart of accounts segment instances as BI-enabled:

1. In the Search Results section of the Manage Key Flexfields window, select Accounting Flexfield and click the Manage Structure Instances button to navigate to the Manage Key Flexfield Structure Instances window.
2. In the Search section, select the chart of accounts for Structure Name and click the Search button.
3. In the Search Results section, select the structure instance and click Edit to navigate to the Edit Key Flexfield Structure Instance window.
4. Check the Enabled check box to code-enable the structure instance.
5. In the Segment Instances section, select the segment instances and click Edit to update. Each of the segment instances must be selected individually.
6. Select the Business Intelligence enabled check box in the Edit Key Flexfield Segment pop-up window and click OK to return to Edit Key Flexfield Structure Instance window.
7. After you have enabled all applicable segment instances for Business Intelligence, click Save and Close to save the changes and return to the Edit Key Flexfield Structure Instance window.
8. Repeat steps 2 - 6 for each chart of accounts to enable all the applicable segment instances for Business Intelligence.
9. Click Done to return to the Manage Key Flexfields window.
10. After you have configured all the charts of accounts, click the Deploy Flexfield button to deploy the Accounting Flexfield and make the latest definition available for use.

### Deploying Accounting Key Flexfields

After you have set up accounting key flexfields, you must deploy them.

Accounting key flexfields have one of the following deployment statuses:

- Edited: The flexfield definition has not been deployed or changes have been made to the structure, the structure instances, or the value sets.
- Patched: The flexfield definition has been modified through an update, but the flexfield has not yet been deployed so the updated definition is not reflected.
- Deployed to Sandbox: The flexfield is deployed and available in a flexfield-enabled sandbox.
- Deployed: The flexfield definition is deployed and available to end users.
- Error: The deployment attempt failed.

To deploy accounting key flexfields:

1. In the Setup and Maintenance work area, go to the Manage Chart of Accounts task.
2. Click Search.
3. Locate the Deployment Status column.
4. Click the icon.
5. Select Edited.
6. Click Deploy Flexfield.
7. Monitor the Deployment Status and when it reaches 100% click **OK**.
8. Verify that a check mark displays in the Deployment Status column.
9. Click **Done**.

Configure Descriptive Flexfields for Transactional Business Intelligence

Overview of Transactional Business Intelligence Configuration of Descriptive Flexfields

Configure descriptive flexfields to track unique information not typically found on business forms. Descriptive flexfields can store several important details on a form without cluttering it. For example, several details may make an asset form heavy and unmanageable. However, the user still needs to access those details and therefore, they must be present on the form. In such cases, descriptive flexfields are convenient to use and are easy to manage.

Descriptive flexfields provide a way for you to add attributes to entities and to define validation and display properties for them. A descriptive flexfield is a logical grouping of attributes (segments) that are mapped to a set of extension columns which are shipped as part of Oracle Applications Cloud tables.

Configure Descriptive Flexfield Segments

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business Intelligence.

Configuring a Descriptive Flexfield Segment

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business Intelligence.

To configure available descriptive flexfield segments:

1. In the Setup and Maintenance work area, go to the **Manage Descriptive Flexfields** task.
2. If the **BI Enabled** option is cleared, select it.
3. Select the options for deployment of the descriptive flexfields.

Set Descriptive Flexfields as BI-Enabled

If a descriptive flexfield is already defined, you can enable it for use in Business Intelligence reports. Not all descriptive flexfields are supported for Business Intelligence.

Setting a Flexfield as BI-Enabled

1. In the Setup and Maintenance work area, go to the **Manage Descriptive Flexfields** task.
2. Navigate to the **Edit Descriptive Flexfields** window.
3. Enter the descriptive flexfield name.
4. Check the BI Enabled option on the desired descriptive flexfields. If the option is unavailable, the flexfield is a non-supported entity.
5. Click OK.
6. Click Save.

Configure Extensible Flexfields for Transactional Business Intelligence

Configure Extensible Flexfields

You can use extensible flexfields to configure more segments.

An extensible flexfield is similar to a descriptive flexfield in that it provides an expansion space that you can use to configure additional attributes (segments) without additional programming. As with descriptive flexfields, each segment is represented in the database as a single column. However, with extensible flexfields, the context values and context-sensitive segments are stored in an extension table.

Categories and Contexts

You can combine and arrange the segments into attribute groups that are tailored to your specific needs. For example, you can group related segments so that they appear together on the page. The attribute groups are referred to as contexts. You can optionally set up an extensible flexfield to enable categorization of contexts.

You can add contexts and segments to extensible flexfields just like the descriptive flexfields. To see the extensible flexfields in analyses, you need to deploy them and then run the BI Extender Essbase scheduled process.

Configuring Extensible Flexfields

To configure extensible flexfields:

1. In the Setup and Maintenance work area, go to the Manage Extensible Flexfield task.
2. Search for the EFF you want to configure, then select it and click the Edit icon.
3. In the Edit Extensible Flexfield dialog, highlight the category Display Name, then select Manage Contexts.
4. In the Manage Context dialog, search for the context that contains the segment you want to configure, highlight it, then click the Edit icon.
5. In the Edit Context dialog, click the Edit icon.
6. Edit the segment, as required, then click Save.

Related Topics

• Flexfield Usages
Set Extensible Flexfields as BI-Enabled
Extensible flexfields are BI enabled if at least one segment in a context is BI enabled.

Setting Extensible Flexfields as BI-Enabled
To set extensible flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Extensible Flexfields task.
2. Enter the extensible flexfield name; for example, Organization Information EFF.
3. Select the applicable extensible flexfield, and then click Edit.
4. Select the applicable Category. The category contexts are populated automatically.
5. Click Manage Contexts
6. In the Edit Context page, select the applicable Context, and then click Edit.
7. Select the applicable Segment, and then click Edit.
8. In the Edit Segment page, select the BI Enabled check box.
9. Click Save.

Overview of the Essbase Rule File and Cubes
Generate the Essbase rule file by running the Create Rules XML File for BI Extender Automation scheduled process. The Essbase rule file must be generated for all Oracle Essbase cubes mapped in the repository file (RPD).

Job Status Conditions
The process status displays one of these conditions.

- INIT: The process has just begun and is waiting for the extender command line JAR to update the status with more details.
- COMPLETED_NO_EXTENSION_NEEDED: No new Flexfield changes were detected in any of the Oracle Applications Cloud sources; because the RPD is already synchronized with all Flexfield changes, no changes were made in the RPD.
- COMPLETED: The RPD was successfully updated with Flexfield changes and uploaded into the Oracle Business Intelligence server.
- FAILED: Error conditions exist which require manual intervention.

Related Topics
- Submit Scheduled Processes and Process Sets

Import Changes to Flexfields Automatically
Overview of Flexfield Change Import

You can use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to import your flexfield changes.

Use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to automatically import the following types of changes:

- Key Flexfield changes
- Descriptive Flexfield changes
- Extensible Flexfield changes

The Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process imports extensible data, including data in descriptive flexfield segments, key flexfield segments, and General Ledger balances in Essbase cubes.

If you have changes to key flexfields and descriptive flexfields, you can import all the changes in the same scheduled process.

This is an Oracle Applications Cloud scheduled process; it is not related to BI Applications. Detailed information on this process can be found in Oracle Applications Cloud documentation.

**Note:** We strongly recommend that you backup the Oracle Business Intelligence Enterprise Edition prior to importing any flexfield changes. Running the process disconnects all users from the server. You should not run this process when maintenance operations or system updates are being performed on the server.

Run the Import Scheduled Process

To import changes, run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process.

Running the Job

To run the process:

1. In the **Scheduled Processes** window, select **Search and Select: Name**.
2. Select **Search and Select: Name**.
3. Highlight **Import Oracle Fusion Data Extensions for Transactional Business Intelligence**.
4. Click **OK**.
5. Schedule the process.

Process Status Conditions

When the process is finished, the biExtenderCMDUtility.jar writes the status of the process into the JNDI file ess_biExtenderEssJob_jobStatus, which can be viewed in Oracle WebLogic Server.

The process status displays one of the following conditions:

- **INIT**: The process has just begun and is waiting for the extender command line JAR to update the status with more details.
- **COMPLETED_NO_EXTENSION_NEEDED**: No new Flexfield changes were detected in any of the Oracle Applications Cloud sources; because the Oracle Business Intelligence is already synchronized with all Flexfield changes, no changes were made in the Oracle Business Intelligence.
• COMPLETED: Oracle Business Intelligence was successfully updated with Flexfield changes and uploaded into the Oracle Business Intelligence Server.
• COMPLETED: PROCESS_ERRORS: Oracle Business Intelligence was updated with the Flexfield changes but with some warnings that require manual intervention.
• FAILED: Error conditions exist that require manual intervention.

Successful Import Process
If the import process is successful, you can perform the following actions:
• Query subject areas by segment dimensions such as Balancing Segment and Cost Center.
• Access DFF attributes for analyses.
• Use the General Ledger - Balances Real Time subject area to query Oracle Essbase cubes.

Disable Flexfields as BI-Enabled

Overview
If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled. There may be times, such as during development phases, when you try using a flexfield and later determine it is no longer needed.

Note: If you are considering disabling flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence. If you disable a flexfield, it cannot be deployed. Also, error conditions may occur if you disable a descriptive flexfield that has been implemented in BI Applications. If error conditions arise from disabling flexfields as BI-enabled, troubleshooting the errors can be difficult and time-consuming.

Disable Key Flexfields as BI-Enabled
If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.
If you are considering disabling key flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence.

Disabling Key Flexfields
To disable key flexfields as BI-enabled:
1. In the Setup and Maintenance work area, go to the Manage Key Flexfields task.
2. Enter your search value in Key Flexfield Code.
3. Click Manage Structure Instances.
4. Enter your search value in Structure Instance Code.
5. Click Edit. The Edit Key Flexfield Structure Instance dialog box displays.
6. In Edit Key Flexfield Segment Instance, deselect the BI Enabled option.
7. Click OK, then Save.
Disable Descriptive Flexfields as BI-Enabled

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling descriptive flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence.

Disabling Descriptive Flexfields

To disable descriptive flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Descriptive Flexfields task.
2. Enter the Descriptive Flexfield Name.
3. Deselect the BI Enabled option on the desired descriptive flexfields.
4. Click OK, then Save.

Disable Extensible Flexfields as BI-Enabled

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling extensible flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Oracle Transactional Business Intelligence.

Disabling Extensible Flexfields

To disable extensible flexfields as BI-enabled:

1. In the Setup and Maintenance work area, go to the Manage Extensible Flexfields task.
2. Enter the extensible flexfield Name; for example, “Organization Information EFF.”
3. Select the applicable extensible flexfield and click Edit to navigate to Edit Extensible Flexfield.
4. Select the applicable Category. The category contexts are populated automatically.
5. Click Manage Contexts to navigate to Manage Contexts.
6. Select the applicable Context and click Edit to navigate to Edit Context.
7. Select the applicable Segment and click Edit to navigate to Edit Segment.
8. Deselect the BI Enabled option.
9. Click Save.

Dimensions Supported by Descriptive Flexfields

SCM Descriptive Flexfields for Business Intelligence

This table shows the Supply Chain Management product area dimensions supported by descriptive flexfields.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Code</th>
<th>Dimension Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARRIER_ ORGANIZATION</td>
<td>Dim - Shipping Method</td>
</tr>
<tr>
<td>Descriptive Flexfield Code</td>
<td>Dimension Name</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>CST_ ANALYSIS_ CODES_B</td>
<td>Dim - Cost Analysis Group</td>
</tr>
<tr>
<td>CST_ ANALYSIS_ GROUPS_B</td>
<td>Dim - Cost Analysis Group</td>
</tr>
<tr>
<td>CST_ COST_ BOOKS_B</td>
<td>Dim - Cost Organization Book</td>
</tr>
<tr>
<td>CST_ COST_ ELEMENTS_B</td>
<td>Dim - Cost Element</td>
</tr>
<tr>
<td>CST_ COST_ ORG_BOOKS</td>
<td>Dim - Cost Organization Book</td>
</tr>
<tr>
<td>CST_ELEMENT_ ANALYSIS_ GROUPS</td>
<td>Dim - Cost Analysis Group</td>
</tr>
<tr>
<td>CST_VAL_ STRUCTURES_B</td>
<td>Dim - Cost Valuation Unit</td>
</tr>
<tr>
<td>CST_VAL_UNITS_B</td>
<td>Dim - Cost Valuation Unit</td>
</tr>
<tr>
<td>DOO_PROCESS_DEFS_ADD_INFO</td>
<td>Dim - DOO Process</td>
</tr>
<tr>
<td>DOO_PROCESS_STEPS_ADD_INFO</td>
<td>Dim - Step</td>
</tr>
<tr>
<td>DOO_TASK_TYPES_ADD_INFO</td>
<td>Dim - Primary Task</td>
</tr>
<tr>
<td>EGO_CHANGE_LINE</td>
<td>Dim - New Item Request Line Details</td>
</tr>
<tr>
<td>EGO_ENGINEERING_ CHANGES</td>
<td>Dim - New Item Request Details</td>
</tr>
<tr>
<td>EGP_CATEGORY_DFF</td>
<td>Dim - Item</td>
</tr>
<tr>
<td>EGP_CATEGORY_SETS_DFF</td>
<td>Dim - Item</td>
</tr>
<tr>
<td>EGP_COMPONENT_DFF</td>
<td>Dim - PIM - Components Details</td>
</tr>
<tr>
<td>EGP_ITEM_CLASS_DFF</td>
<td>Dim - PIM - Item Class</td>
</tr>
<tr>
<td>EGP_ITEM_RELATIONSHIPS_DFF</td>
<td>Dim - Cross Reference Item Details</td>
</tr>
<tr>
<td>EGP_ITEM_REVISIONS_DFF</td>
<td>Dim - PIM - Item and Revisions Details</td>
</tr>
<tr>
<td>Descriptive Flexfield Code</td>
<td>Dimension Name</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>EGP_REFERENCE_DESIGNATOR_DFF</td>
<td>Dim - PIM - Reference Designator</td>
</tr>
<tr>
<td>EGP_STRUCTURE_HEADER_DFF</td>
<td>Dim - PIM - Structure Details</td>
</tr>
<tr>
<td>EGP_SUBSTITUTE_COMPONENT_DFF</td>
<td>Dim - PIM - Substitute Component</td>
</tr>
<tr>
<td>EGP_SYSTEM_ITEMS_DFF</td>
<td>Dim - Item</td>
</tr>
<tr>
<td>EGP_TRADING_PARTNER_ITEMS_DFF</td>
<td>Dim - Trading Partner Item Details</td>
</tr>
<tr>
<td>GMS_AWARD_HEADERS_DFF</td>
<td>Dim - Award</td>
</tr>
<tr>
<td>GMS_AWARD_PERSONNEL_DFF</td>
<td>Dim - Personnel</td>
</tr>
<tr>
<td>GMS_AWARD_PROJECTS_DFF</td>
<td>Dim - Award Project</td>
</tr>
<tr>
<td>GMS_INSTITUTIONS_DFF</td>
<td>Dim - Award</td>
</tr>
<tr>
<td>INV_GRADES</td>
<td>Dim - Inventory Grade</td>
</tr>
<tr>
<td>INV_ITEM_LOCATIONS</td>
<td>Dim - Storage Location</td>
</tr>
<tr>
<td>INV_LOT_ATTRIBUTES</td>
<td>Dim - Inventory Lot, Dim - Product Lot Number, Dim - Component Lot Number</td>
</tr>
<tr>
<td>INV_LOT_NUMBERS</td>
<td>Dim - Inventory Lot, Dim - Product Lot Number, Dim - Component Lot Number</td>
</tr>
<tr>
<td>INV_MATERIAL_TXNS</td>
<td>Dim - Inventory Details</td>
</tr>
<tr>
<td>INV_ORG_PARAMETERS</td>
<td>Dim - Inventory Org</td>
</tr>
<tr>
<td>INV_SECONDARY_INVENTORIES</td>
<td>Dim - Storage Location</td>
</tr>
<tr>
<td>INV_SERIAL_ATTRIBUTES</td>
<td>Dim - Product Serial Number, Dim - Component Serial Number</td>
</tr>
<tr>
<td>INV_SERIAL_NUMBERS</td>
<td>Dim - Product Serial Number, Dim - Component Serial Number</td>
</tr>
<tr>
<td>Descriptive Flexfield Code</td>
<td>Dimension Name</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>INV_. TRANSACTION_. REASONS</td>
<td>Dim - Receipt Transaction Reasons</td>
</tr>
<tr>
<td>INV_. TRANSACTION_. TYPES</td>
<td>Dim - Movement Types</td>
</tr>
<tr>
<td>INV_. TXN_. SOURCE_TYPES</td>
<td>Dim - Inventory Transaction Source Type</td>
</tr>
<tr>
<td>RCV_. SHIPMENT_. HEADERS</td>
<td>Dim - Inbound Shipment Details</td>
</tr>
<tr>
<td>RCV_. SHIPMENT_. LINES</td>
<td>Dim - Inbound Shipment Details</td>
</tr>
<tr>
<td>RCV_. TRANSACTIONS</td>
<td>Dim - Receipt Details</td>
</tr>
<tr>
<td>WIE_. OPERATION_. TRANSACTIONS</td>
<td>Dim - Operation Transaction Details</td>
</tr>
<tr>
<td>WIE_. RESOURCE_. TRANSACTIONS</td>
<td>Dim - Resource Transaction Details</td>
</tr>
<tr>
<td>WIE_. WO_. OPERATION_. MATERIALS</td>
<td>Dim - Work Order Operation Materials</td>
</tr>
<tr>
<td>WIE_. WO_. OPERATION_. OUTPUTS</td>
<td>Dim - Work Order Operation Output Details</td>
</tr>
<tr>
<td>WIE_. WO_. OPERATION_. RESOURCE_ Instances</td>
<td>Dim - Work Order Operation Resources</td>
</tr>
<tr>
<td>WIE_. WO_. OPERATION_. RESOURCES</td>
<td>Dim - Work Order Operation Resources</td>
</tr>
<tr>
<td>WIE_. WO_. OPERATIONS</td>
<td>Dim - Work Order Operations</td>
</tr>
<tr>
<td>WIE_. WORK_ORDERS</td>
<td>Dim - Work Orders</td>
</tr>
<tr>
<td>WIS_. EQUIPMENT_ RESOURCE_ INSTANCES</td>
<td>Dim - Resource Instance</td>
</tr>
<tr>
<td>WIS_. LABOR_ RESOURCE_ INSTANCES</td>
<td>Dim - Resource Instance</td>
</tr>
<tr>
<td>WIS_. WORK_AREAS</td>
<td>Dim - Manufacturing Work Center</td>
</tr>
<tr>
<td>WIS_. WORK_CENTERS</td>
<td>Dim - Manufacturing Work Center</td>
</tr>
<tr>
<td>Descriptive Flexfield Code</td>
<td>Dimension Name</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>WSH_CARRIERS</td>
<td>Dim - Carrier</td>
</tr>
<tr>
<td>WSH_DELIVERY_DETAILS</td>
<td>Dim - Sales Pick Details</td>
</tr>
<tr>
<td>WSH_NEW_DELIVERIES</td>
<td>Dim - Sales Pick Details</td>
</tr>
</tbody>
</table>
Chapter 5

5 Analytics Modification

Overview of Analytics Creation and Modification

Edit and create *analytics* to provide ad hoc reporting on your transactional data. The predefined *analyses* and *dashboards* help answer many of your business questions, but you can also create your own to meet your requirements. This table gives a just a few examples of creating or editing analytics.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an analysis</td>
<td>Your team needs a simple list of all your accounts, sorted by account ID. You include the account name, ID, and address in a new analysis, and add sorting on the ID column.</td>
</tr>
<tr>
<td>Create a view</td>
<td>A predefined analysis has a bar graph. You save a new version of this analysis with a table view added to the graph.</td>
</tr>
<tr>
<td>Create a view selector</td>
<td>You later decide that you want to toggle between viewing a table and a graph. You add a view selector that includes the table and graph views.</td>
</tr>
<tr>
<td>Edit a dashboard prompt</td>
<td>A predefined dashboard has a Start Date prompt. You make a copy of the dashboard and replace Start Date with a date range prompt.</td>
</tr>
<tr>
<td>Create a dashboard</td>
<td>You create a dashboard that includes an analysis and a report to view both together.</td>
</tr>
</tbody>
</table>

**Tip:** A wizard in the Reports and Analytics work area and panel tab is available to help you create or edit analyses.

Data Source Modification

Administrators can modify the *business intelligence (BI) repository* to determine the columns available for you to use.

- They enable flexfields (which support attributes) for BI, and import them into the repository.
- You can then select attributes from flexfields to include in your analyses.

*Related Topics*

- Reports and Analytics Work Area and Panel Tab
- How Data Is Structured for Analytics
- Overview of Flexfield Use in Analyses
Analyses

Create and Edit Analyses Using a Wizard

You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn’t give you all available features, you can still use it to make typical changes, for example adding views or filters. For other tasks, such as creating dashboards or deleting analyses, use the advanced business intelligence features.

Creating an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click Create and select Analysis.
3. Select the subject area that has the columns you want for your analysis.
4. Optionally, add more subject areas or remove any that you no longer need.
5. Select the columns to include, set options for each column, and click Next.
6. Optionally, enter a title to display for the analysis.
7. Select the type of table or graph to include, specify the layout of the views, and click Next.

   Note: At any point after this step, you can click Finish to go to the last step, to save your analysis.

8. Optionally, set more options for the table or graph, and click Next.
9. Optionally, add sorts or filters based on any of the columns you included, and click Next.
10. If you have a table, optionally define conditional formatting for select columns, for example to display amounts over a certain threshold in red. Click Next.
11. Enter the name of your analysis and select a folder to save it in.
12. Click Submit.

Editing an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and edit it. In the Reports and Analytics work area, click More for the analysis and select Edit. In the Reports and Analytics panel tab, click the analysis, then click Edit.
3. Perform steps 4 through 10 from the preceding Creating an Analysis task, as needed.
4. To update an existing analysis, select the same name in the same folder. To save this analysis as a new copy, either name it with a new name or save it in a new folder.
5. Click Submit.

Related Topics

- Reports and Analytics Work Area and Panel Tab
- Where to Save Analytics and Reports
- How Data Is Structured for Analytics
Manage Analytics with Advanced Features

Even though you can use a wizard to create or edit analyses, you might have to use advanced features for complicated analyses or specific requirements. For example, you can create view selectors so that users can toggle between views within an analysis, or define criteria for filters using SQL statements.

You can also perform other actions on analyses, for example delete them or copy and paste them within the business intelligence catalog.

How to Create and Edit Analytics

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click the Browse Catalog button.
3. Click the New button, select Analysis in Analysis and Interactive Reporting, and select a subject area.
   Or, select your analysis in the Folders pane and click Edit.
4. Use the tabs as described in this table.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria</td>
<td>Select and define the columns to include.</td>
</tr>
<tr>
<td></td>
<td>Add filters.</td>
</tr>
<tr>
<td>Results</td>
<td>Add views and set options for results.</td>
</tr>
<tr>
<td>Prompts</td>
<td>Define prompts to filter all views in the analysis.</td>
</tr>
<tr>
<td>Advanced</td>
<td>View or update the XML code and logical SQL statement that the analysis generates. Set options related to query performance.</td>
</tr>
</tbody>
</table>

5. Save your analysis.

More Actions on Analytics

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and click Action and select More.
3. Click More for your analysis and select the wanted action, for example Delete or Copy.

Related Topics

- Reports and Analytics Work Area and Panel Tab
- How Data Is Structured for Analytics
- Where to Save Analytics and Reports
Create a Change Order Approval Cycle Time by Reason Analysis

You are a product manager and you want to create an analysis to help you review change order approval cycle times. The approval times are to be analyzed by change reasons.

The following table summarizes key decisions for creating the analysis.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
</table>
| What information to include? | - Change Order Approval Cycle Time  
- Reason |
| What type of layout is required? | Table with a bar below it |
| Is this analysis available for others to use? | No. Save it to My Folders. |

To create an analysis of Change Order Approval Cycle time by Reason, complete these tasks:

1. Select columns
2. Define the layout
3. Save the analysis

Selecting Columns

1. Navigate to Reports and Analytics work area.
2. Click **Create**.
3. Select **Analysis**.
4. In the Select Subject Area Window, select the **Product Management - Change Order Real Time** subject area.
5. On the Create Analysis: Select Columns page, expand the **Product Management - Change Order Real Time** folder.
6. Expand the **Change Order** folder.
7. Select **Approval Cycle Time** and click the **Add** icon button to move the column to the Selected Columns area.
8. Expand the **Change Order Reason** folder.
9. Select **Change Order Reason** and click the **Add** icon button to move the column to the Selected Columns area.
10. Click **Next**.

Defining the Layout

1. On the Create Analysis: Select Views page, enter Change Order Approval Cycle Time in the **Name** field.
2. Next to the Table field, click **None** to open the Table menu.
3. Select **Table (recommended)**.
4. Next to the Graph field, click **None** to open the Graph menu.
5. Select **Bar (recommended)**.
6. Use the default layout value of Table above Graph.
7. Click **Next**.
8. On the Create Analysis: Edit Table page, select Change Order Reason and click the **Move selected item to top of list** icon.
9. Click **Next**.
10. On the Create Analysis: Edit Graph page, click **Next**.
11. On the Create Analysis: Sort and Filter Page, click **Next**.

### Saving the Analysis

1. On the Create Analysis: Save page, enter *Change Order Approval Cycle Time by Reason* in the **Analysis Name** field, enter a description and then select **My folders** in the Save In region.
2. Click **Submit**.
3. Click **OK**.

### Use UOM Columns with ToUOM Session Variable in Dashboards, Analyses

You can use predefined columns in some subject areas for Oracle Supply Chain Planning Cloud and the `toUOM` session variable to author dashboards and analyses in which the primary or transaction unit of measure (UOM) for data is changed to a reporting UOM.

You can use these columns with the `toUOM` session variable:

- **Reporting UOM Prompt**: Use this column only to create prompts in dashboards and analyses. This column returns UOM values from `INV_UNITS_OF_MEASURE_TL.UNIT_OF_MEASURE` or UOM codes from `INV_UNITS_OF_MEASURE_B.UOM_CODE`.
- **UOM Conversion From Primary to Reporting**: Use this column to get the conversion factor from the primary to the reporting UOM. Then, multiply the quantity in the primary UOM with the conversion factor to get the quantity in the reporting UOM.
- **UOM Conversion From Transaction to Reporting**: Use this column to get the conversion factor from the transaction to the reporting UOM. Then, multiply the quantity in the transaction UOM with the conversion factor to get the quantity in the reporting UOM.

The predefined columns are available in these subject areas:

- **Costing - Work Order Costs Real Time**
- **Inventory - Inventory Balance Real Time**
- **Inventory - Inventory Transactions Real Time**
- **Manufacturing - Actual Production Real Time**
- **Order Management - Fulfillment Lines Real Time**
- **Order Management - Order Lines Real Time**
- **Shipping Real Time**

You can use these columns and the `toUOM` session variable in these ways:

- Create a UOM prompt for a dashboard
- Create a UOM prompt for an analysis
- Set the `toUOM` session variable to a UOM code in an analysis

### Create a UOM Prompt for a Dashboard

To create a UOM prompt for a dashboard, follow these steps:

1. Create an analysis for a subject area that has the predefined columns.
To provide the user with the UOM conversion factor, include the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column.

1. Save the analysis.

2. Create a column-based dashboard prompt for the subject area.
   a. Under Definition, click New, and select Column Prompt.
      The Select Column dialog box opens.
   b. Select the Reporting UOM Prompt column, and click OK.
      The New Prompt dialog box opens.
   c. Under Options, select Request Variable in the Set a variable list.
      A field appears under the list.
   d. Enter ToUOM in the field.
   e. Save the dashboard prompt.

3. Create a dashboard.
   a. Add the dashboard prompt and analysis to the dashboard.
   b. Save the dashboard.

When you change the value in the Reporting UOM Prompt list of the dashboard, the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column shows the conversion factor from the primary or transaction UOM to the reporting UOM.

Create a UOM Prompt for an Analysis
The procedure described in this section requires you to know the corresponding codes for UOM values.

To create a UOM prompt for an analysis, follow these steps:

1. Create an analysis for a subject area that has the predefined columns.
   To provide the user with the UOM conversion factor, include the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column.

2. On the Prompts tab, click New, and select Variable Prompt.
   The New Prompt dialog box opens.

3. In the Prompt for list, select Request Variable.

4. In the field next to the Prompt for list, enter ToUOM.

5. In the User Input list, select Choice List.
   The Choice List Values list appears.

6. In the list, select SQL Results.
   A field for entering SQL code appears.

7. Replace the SQL statement with another in the following format:
   SELECT DESCRIPTOR_IDOF("<subject area>"."Reporting UOM Prompt") FROM "<subject area>" FETCH FIRST 65001 ROWS ONLY
   Substitute values for the text within the angle brackets.
   For example, a complete SQL statement is as follows:
   SELECT DESCRIPTOR_IDOF("Inventory - Inventory Balance Real Time"."- Main"."Reporting UOM Prompt") FROM "Inventory - Inventory Balance Real Time" FETCH FIRST 65001 ROWS ONLY
8. Click OK.
9. Save the analysis.

When you run the analysis, you're first prompted to select a UOM code in a list. When you click OK, the analysis results are displayed, and the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column shows the conversion factor from the primary or transaction UOM to the reporting UOM.

Set the ToUOM Session Variable to a UOM Code in an Analysis
The procedure described in this section requires you to know the corresponding codes for UOM values.

To set the ToUOM session variable to a UOM code in an analysis, follow these steps:

1. Create an analysis for a subject area that has the predefined columns.
   To provide the user with the UOM conversion factor, include the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column.
2. On the Advanced tab, under Advanced SQL Clauses, in Prefix, enter an SQL statement in the following format:
   \[ \text{SET VARIABLE ToUOM} = \langle \text{UOM Code} \rangle; \]
   Substitute a UOM code for the text within the angle brackets.
   For example, a complete SQL statement is as follows: \[ \text{SET VARIABLE ToUOM} = \text{'B050'}; \]
3. Click Apply SQL.
4. Save the analysis.

When you run the analysis, the UOM Conversion From Primary to Reporting or UOM Conversion From Transaction to Reporting column shows the conversion factor from the primary or transaction UOM to the reporting UOM. Moreover, you can't select any other code for the reporting UOM.

Related Topics
- Supply Chain Management Repository and Session Variables for Business Intelligence

How can I provide access to a custom analysis or report to multiple users?

By default, shared analyses and reports are owned by the duty role of the user who created them. All users with that duty role are able to view, modify, and save the objects.

Cross-Subject Area Joins

Overview of Cross-Subject Area Joins
You can create analyses that combine data from more than one subject area. This type of query is referred to as a cross-subject area analysis. Review guidelines for creating these joins in MyOracle Support (Doc ID 1567672.1). Cross-subject area analyses can be classified into three broad categories:

- Using common dimensions.
- Using common and local dimensions.
• Combining more than one result set from different subject areas using set operators such as union, union all, intersection and difference.

Common Dimensions
A common dimension is a dimension that exists in all subject areas that are being joined in the report. These dimensions are considered common dimensions between subject areas and can be used to build a cross-subject area report.

Common and Local Dimensions
A local dimension is available only in one of the combined subject areas in a cross-subject area query.

Create a Cross-Subject Area Analysis
To create a real-time analysis that includes more than one subject area, which is referred to as a cross-subject area analysis, the analysis must include a measure from each of the subject areas to support the join if it uses a local dimension. You can hide the measure in the results if you don’t want it to appear in your analysis.

Creating a Cross-Subject Area Analysis
1. In the Reports and Analytics work area, click Browse Catalog.
2. Click New and select Analysis.
3. In the Select Subject Area window, select a subject area.
4. In the Criteria tab, expand the dimensions and add a column to the analysis.
5. In the Subject Areas region, click Add/Remove Subject Areas.
6. In the Subject Area region of the Criteria tab, expand the dimensions and add a column to the analysis.
7. If the column is a local dimension, add a measure from the subject area. If it's preferable to hide the measure in your analysis, select its Column Properties, and in the Column Format tab of the Column Properties dialog box, select the Hide check box and click OK.
8. If you are using a local dimension, in the Advanced tab, navigate to the Advanced SQL Clauses section, select Show Total value for all measures on unrelated dimensions, then click Apply SQL.
9. Click the Results tab to see the results of the analysis.
10. Click the Criteria tab again to return to the analysis definition.

Dashboards
Create and Edit Dashboards
Dashboards give you a palette to add one or more objects for display. You can create and edit dashboards and define their content and layout. In addition to objects in the business intelligence (BI) catalog, such as analyses, reports, and prompts, you can add text, sections, and more to a dashboard.
Create a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click Browse Catalog.
3. Click New and select Dashboard under Analysis and Interactive Reporting.
4. Enter the dashboard’s name and description, and select a folder to save in.
5. With the Add content now option selected, click OK.
6. Optionally, add more pages, or tabs, within the dashboard.
7. Drag and drop items from the Dashboard Objects or Catalog pane to add content to a page.
8. Click Save.

Note: The first dashboard page is saved with the page 1 name by default. To rename this page:
   1. Click the Catalog link.
   2. In the Folders pane, select your dashboard.
   3. For page 1, click More and select Rename.
   4. Enter the new name and click OK.

Edit a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the dashboard.
2. Select your dashboard in the pane and click More.
3. Click Edit.
4. Perform steps 5 and 6 from the preceding Creating Dashboards task, and make other changes as needed, for example:
   - Remove content from the dashboard.
   - Drag and drop within a page to move content around.
   - Change the layout of a page.

Related Topics
- Where to Save Analytics and Reports
- Reports and Analytics Work Area and Panel Tab

FAQs for Analyses and Dashboards

What are subject areas, dimensions, attributes, facts, and metrics?

Information for your analytics is grouped into related functional areas called subject areas, which contain fact and dimension folders with columns and metrics used for analytics.

Dimension folders include the grouping of dimensional attributes for the subject area. Columns (such as date of birth or name) which are grouped for a dimension are known as attributes. Fact folders contain formulas for getting numeric values, such as counts and percentages.
What's the relationship between dimensions and fact in a subject area?

A subject area is based around a single fact. The dimensions are all related to each other through the fact only. The fact is automatically included in any query that is created, even if none of the measures in the fact appear in the analysis.

What's a common dimension?

A common dimension is shared across multiple subject areas. For example, Time, Department, and Location are common dimensions. When constructing a cross-subject area analysis, only common dimensions can be used.

How can I determine which dimensions are shared across two subject areas?

If the dimensions exist in both subject areas, they are common dimensions, and are often among the first folders in a subject area. You can join any subject areas you have access to in Answers, but analyses are subject to the normalized data structure. Unless the underlying tables are joined by design, joining subject areas in Answers results in errors.

How can I identify subject areas to create analyses?

All OTBI subject area names end with the words "Real Time".

Can I change the columns in subject areas?

You can use only the available subject areas and their dimensions and facts. You can use other The data elements that are provided out of the box are the only ones that the customers can make use of. You can potentially use BI-enabled flexfields to analyze any column in the transactional tables.

Do analyses query transactional tables to display data?

Analyses run real-time queries of transactional tables through View Objects. Oracle Fusion data security, flexfields, user interface hints, lists of values, and other metadata are delivered through the View Objects.

What's a dashboard?

A dashboard is a container page to display analyses, reports, and other objects. Administrators can create shared dashboards for groups of users with common responsibilities or job functions. Personalized views can be created based on a user's permissions.
6 Reports Modification

Overview of Business Intelligence Publisher

Oracle Business Intelligence (BI) Publisher enables you to author, generate, and deliver all types of highly formatted documents and operational reports. You can use familiar office desktop tools to create rich text format (.rtf) documents and reports against any data source. You can view reports, schedule them to run, and distribute them to predefined destinations.

A BI Publisher report consists of one or more .rtf layouts, a reference to a data model, and a set of properties. A report may also include style templates and subtemplates, which allow reusability of functionality and maintain consistency of design. In the logical architecture depicted in the figure, the report includes a data model and a layout, and the layout references two style templates in the catalog which in turn reference subtemplates.

In the BI Publisher logical architecture, the data model accesses data sources and the layout and its optional style template and subtemplates determine the formatting of the report output, which can include email, print, fax, or files, and others. The layout is designed using common office applications, for example Microsoft Word and Excel and Adobe Acrobat and Flash, among others.
Style Templates

A style template is a .rtf template that contains style information that can be applied to report layouts.

A style template is a .rtf template that contains style information that can be applied to report layouts at runtime to achieve a consistent look and feel across your enterprise reports. You associate a style template to a report layout in the report definition. Using a style template has the following benefits:

- Enables the same look and feel across your reports
- Enables consistent header and footer content, such as company logos, headings, and page numbering
- Simplifies changing elements and styles across all reports

Use style templates to define paragraph and heading styles, table styles, and header and footer content.

Paragraph and Heading Styles

When the named style is used in a report layout, the report layout inherits the following from the style template definition:

- font family
- font size
- font weight (normal, bold)
- font style (normal, italic)
- font color
- text decoration (underline or strike through)

Table Styles

Style elements inherited from the table style definition include:

- font style
- border style
- line definition
- shading
- text alignment

Header and Footer Content

The header and footer regions of the style template are applied to the report layout. This includes images, dates, page numbers, and any other text-based content. If the report layout also includes header and footer content, then it is overwritten.
Subtemplates

A subtemplate is a piece of formatting functionality in .rtf or .xsl format that can be defined once and used multiple times within a single layout template or across multiple report layout template files. Rich Text Format (RTF) subtemplates are easy to design using native features in Microsoft Word, while subtemplates using Extensible Stylesheet Language (XSL) can be used for complex layout and data requirements. Both .rtf and .xsl subtemplates are stored in the business intelligence catalog as a subtemplate object, and both can be called from .rtf layout templates.

Some common uses for subtemplates include:

- Reusing a common layout or component (such as a header, footer, or address block)
- Handling parameterized layout
- Handling dynamic or conditional layouts
- Handling lengthy calculations or reusing formulas

RTF Subtemplates

An RTF subtemplate is an RTF file that consists of one or more <?template:?> definitions, each containing a block of formatting or commands, that when uploaded to Business Intelligence (BI) Publisher as a subtemplate object in the catalog can be called from within another RTF template.

XSL Subtemplates

An XSL subtemplate is an XSL file that contains formatting or processing commands in XSL for the Business Intelligence Publisher formatting engine to execute. Use an XSL template to include complex calculations or formatting instructions not supported by the RTF standard.

How You Create and Edit Reports

Use reports to generate and print documents for internal operations, external business transactions, or legal requirements. To meet specific requirements, you must create or edit reports to capture different data, or present data in another way.

Report Components

Each report has components that you can modify, as described in this table:

<table>
<thead>
<tr>
<th>Report Component</th>
<th>Description</th>
<th>Tool for Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data model</td>
<td>Defines the data source, data structure, and parameters for the report. Multiple reports can use the same data model. Each report has one data model.</td>
<td>Data model editor in the application</td>
</tr>
</tbody>
</table>
### Report Component

<table>
<thead>
<tr>
<th>Description</th>
<th>Tool for Modifying</th>
</tr>
</thead>
</table>
| Defines the presentation, formatting, and visualizations of the data. A report can have multiple layouts. Different types of layout templates are available, for example Excel and RTF. | Depending on the template file type:  
- **XPT**: Layout editor in the application  
- **RTF**: Microsoft Word  
- **PDF**: Adobe Acrobat Professional  
- **Excel**: Microsoft Excel  
- **eText**: Microsoft Word |
| Specifies formatting and other settings for the report. | Report editor in the application |

### What You Can Create or Edit

This table gives just a few examples of creating or editing reports.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the layout of a report.</td>
<td>Add your company logo to the report output.</td>
</tr>
<tr>
<td>Add a new layout to a report.</td>
<td>Design a new layout template that provides less detail than the existing template.</td>
</tr>
<tr>
<td>Edit a data model.</td>
<td>Add two fields to the data model used by a report so you can add those new fields to a layout for the report.</td>
</tr>
<tr>
<td>Create a new report based on a new data model.</td>
<td>Create a new data model based on data from an external system, and create reports using the data model.</td>
</tr>
</tbody>
</table>

### How You Access and Modify Report Components

To create or edit reports, you must access the business intelligence (BI) catalog. In the catalog, objects of type Report represent the report definition, which includes report properties and layouts. Data models are separate objects in the catalog, usually stored in subfolders called Data Models.

#### Accessing the BI Catalog

You can access the BI catalog in any of the following ways:

- In the Reports and Analytics work area, click **Browse Catalog** to open the BI catalog, and find your report or data model in the Folders pane.
• In the Reports and Analytics work area, find your report and select More to go to the report directly in the catalog. The data model associated with the report should be in the Data Models subfolder within the same folder as the report.
• Sign in to the application directly (for example: http://host:port/analytics/saw.dll) to open the catalog.
• Sign in to the BI Publisher server directly (for example: http://hostname.com:7001/xmlpserver) to open the catalog.
  o Alternatively, once you are in the catalog using another method, for example, through the Reports and Analytics work area, change the final node of the URL. For example, change (http://host:port/analytics/saw.dll) to xmlpserver. So the URL you use would be: http://host:port/xmlpserver.

Predefined Reports
A special Customize option is available only:
  • For predefined reports, not data models.
  • Through direct access to the BI Publisher server using the /xmlpserver URL. When you find your report in the BI catalog, select Customize from the More menu.

The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom folder within the catalog. The new report is linked to the original, so that when users open or schedule the original, they are actually using the copied version.

If you don't have access to the Customize option or don't want the original version linked to the new report, make a copy of the predefined report and save it in the Custom folder.

Predefined Data Models
Don't edit predefined data models. Instead, copy the data model into the Custom folder and edit the copy. You can't create a new data model based on the transactional tables.

Related Topics
  • Where to Save Analytics and Reports
  • What happens to modified analytics and reports when an update is applied

How You Modify Copies of Predefined Reports
The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom within the business intelligence (BI) catalog. The copy includes the report definition, folder structure, and original report permissions, and is linked internally to the original report. You can edit the copy of the report, leaving the original report intact. When users open or schedule the original report, they are actually using the newer version.

Benefits of the Customize Option
In addition to conveniently copying a predefined report to the Custom folder, the Customize option:
  • Makes it unnecessary to update processes or applications that call the report. For example, if the original report is set up to run as a scheduled process, you don't need to change the setup. When users submit the same scheduled process, the newer report runs instead of the original.
• Automatically copies the security settings of the original report.
• Removes the risk of patches overwriting your edits. If a patch updates the original report, the newer report is not updated in any way.

Note: The report still references the original data model. The data model is not copied. A patch that updates the data structure of the data model might affect your report.

Accessing the Customize Option
To access the Customize option:
2. In the Folders pane, select the predefined report.
3. Select Customize from the More menu for the report.
4. The copied report in the Custom folder opens, so proceed to edit this report.

To edit the copied report again later, you don’t need to be in the BI server. Just go to the BI catalog and either:
• Select the Customize or Edit option for the original report.
• Find your report in the Custom folder and select Edit.

Related Topics
• Where to Save Analytics and Reports
• What happens to modified analytics and reports when an update is applied

How Links Between Original and Modified Reports Are Managed
The Customize option for predefined reports creates a copy of the report that is linked to the original. Consider the following points when you work with both the original and modified versions.

Maintaining the Link Between Reports
The link between the predefined and modified report is based on the name of the modified report and its location within the Custom folder in the business intelligence (BI) catalog.

• If you manually create a report with the same name as a predefined report, and give it the same folder path in the Custom folder, then the new report becomes a version of the original. It would be as if you had used the Customize option to create a copy of the predefined report.
• You can edit the report so that it uses a different data model. But if the original data model is updated later, then your newer report doesn’t benefit from the change.

Caution: The link to the original report breaks if you rename the modified or original report.
# Tasks Performed on Original Reports

This table describes what happens when you use the original report and a corresponding copied report exists.

<table>
<thead>
<tr>
<th>Task Performed on the Original Report</th>
<th>Result When There Is a Copied Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the copied report.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Creates a report submission for the copied report.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the copied report.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the original report only. If you delete the copied report, the original report is not deleted.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the original report.</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>Cuts and pastes the original report.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the original report. The copied report name is not changed.</td>
</tr>
</tbody>
</table>

**Caution:** This breaks the link between the original and copied reports.

<table>
<thead>
<tr>
<th>Download</th>
<th>Downloads the copied report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize</td>
<td>Edits the copied report.</td>
</tr>
<tr>
<td>History</td>
<td>Opens the job history of the copied report.</td>
</tr>
</tbody>
</table>

## Related Topics
- [Where to Save Analytics and Reports](#)
- [What happens to modified analytics and reports when an update is applied](#)

## Layouts
Create and Edit Report Layouts

The layout determines what and how data is displayed on report output. Each report has at least one layout template. This topic describes the following aspects of report templates:

- Layout templates
- Layout template types
- Overall process of managing layouts
- Deleting layout templates

Layout Templates

To modify a layout, you edit the layout template, which:

- Defines the presentation components, such as tables and labeled fields.
- Maps columns from the data model to these components so that the data is displayed in the correct place.
- Defines font sizes, styles, borders, shading, and other formatting, including images such as a company logo.

Layout Template Types

There are a few types of template files to support different report layout requirements.

- **RTF**: Rich text format (RTF) templates created using Microsoft Word.
- **XPT**: Created using the application's layout editor, these templates are for interactive and more visually appealing layouts.
- **eText**: These templates are specifically for Electronic Data Interchange (EDI) and electronic funds transfer (EFT) information.

You can also create and edit other types of templates using Adobe PDF, Microsoft Excel, Adobe Flash, and XSL-FO.

Overall Process to Create or Edit Layouts

Editing or creating report layout, for example using Microsoft Word or the layout editor, involves making the actual changes to the template file. But that task is just one part of the entire process for modifying layouts.

1. Copy the original report and save the new version in Shared Folders > Custom in the business intelligence (BI) catalog. You create or edit templates for the new copy of the report.

   Tip: You can use the Customize option if the original is a predefined report.

2. Review report settings for online viewing.
3. Generate sample data for the report.
4. Edit or create the layout template file.
5. Upload the template file to the report definition. Skip this step if you're using the layout editor.
6. Configure the layout settings.

Deleting Layout Templates

To remove a layout template for a report:

1. Select your report in the BI catalog and click Edit.
2. In the report editor, click View a list.
3. Select the layout template and click **Delete**.

**Make Reports Available for Online Viewing**

Some reports are set up so that you can only view them through another application or submit them as scheduled processes. To view your report online while you're editing it, you must define a few settings. When you're done editing your report, make sure that you reset these settings as needed.

**Updating Report Properties**

1. Select your report in the business intelligence catalog and click **Edit**.
2. In the report editor, click **Properties**.

**Updating Layout Settings**

1. Back in the report editor, click **View a list**.
2. Make sure that the **View Online** check box is selected.

**Generate Sample Report Data**

Depending on the type of report layout changes you're making, sample data can be required or optional. You generate sample data, and then load it for use with your layout so that you can map data fields to layout components. For example, for the Start Date table column in your layout, you can set it so that the data displayed in that column comes from the Start Date field in the sample data.

You can generate sample data from the:

- Report data model
- Report viewer
- Scheduler

**Generate Sample Data from the Data Model**

Follow these steps:

1. Select your data model in the business intelligence (BI) catalog and click **Edit**. Alternatively:
   a. In the catalog, find the report to generate sample data for and click **Edit**.
   b. Click the data model name in the report editor.
2. In the data model editor, click **View Data**.
3. Enter values for any required parameters, select the number of rows to return, and click **View**.
4. To save the sample data to the data model, click **Save As Sample Data**.
   
   If you're designing a .rtf template, click **Export** to save the file locally.
5. Save the data model.
Save Sample Data from the Report Viewer

For reports that are enabled for online viewing, you can save sample data from the report viewer:

1. Select the report in the BI catalog.
2. Click **Open** to run the report in the report viewer with the default parameters.
3. On the Actions menu, click **Export**, then click **Data**.
4. Save the data file.

Save Sample Data from the Scheduler

For reports that are enabled for scheduling (not necessarily as a *scheduled process*), you can save sample data from the scheduler:

1. Select the report in the BI catalog.
2. Click **Schedule**.
3. On the General tab, enter values for any report parameters.
4. On the Output tab, ensure that **Save Data for Republishing** is selected.
5. Click **Submit**.
7. On the global header, click **Open**, then click **Report Job History**.
8. Select your report job name in the Job Histories table.
9. On the details page, in Output and Delivery, click the **XML Data Download** icon button.

Layout Templates

Create and Edit Report Layout Templates Using the Layout Editor

The layout editor in the application provides an intuitive, drag-and-drop interface for creating pixel-perfect *reports* with PDF, RTF, Excel, PowerPoint, and HTML output. The layout template files you create with this tool have an `.xpt` extension. The layout editor tool is the only editing tool that provides dynamic HTML output. Users can interact with this output in a browser, for example by sorting, applying filters, and so on.

**Prerequisite**

Make sure that sample data is generated from the data model that your report is using.

Using the Layout Editor

To create or edit XPT templates:

1. Select the report in the *business intelligence (BI) catalog* and click **Edit**.
2. In the report editor, click **Edit** to update a template.
   
   Or, click **Add New Layout** and select a template type in the Create Layout section.
3. Create or edit the layout.
4. Click **Save** to save the layout to the report definition.

Set Up for RTF and Excel Report Layout Templates

You can use Microsoft Word or Microsoft Excel to create or edit RTF and Excel layout templates, in addition to the layout editor in the application. If you use Word or Excel directly, you must download and install the appropriate add-in so that the Microsoft application has the features you need to design report layouts.
Note: If you're designing a new layout for your report, consider using the layout editor instead unless you are an experienced layout designer.

Installing the Add-In

1. Open the Reports and Analytics work area.
2. Click the Browse Catalog button.
3. Click Home.
4. In the Get Started pane, click Download BI Desktop Tools.
5. Select the add-in for the type of template you're working with.
   - Template Builder for Word: RTF templates
   - Analyzer for Excel: Excel templates
6. Save and then run the installer.

Protecting Reports by Using Passwords

You can assign a password to your report and protect it from unwanted access. You can do this by setting the runtime properties at the server level using the Runtime Configuration page. The same properties can also be set at the report level, from the report editor's Properties dialog. If different values are set for a property at each level, then report level takes precedence.

The following table describes the properties you can use to set passwords for reports in different formats.

<table>
<thead>
<tr>
<th>Report Format</th>
<th>Property Name</th>
<th>Description</th>
<th>Default</th>
<th>Configuration Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any DOCX report.</td>
<td>NA</td>
<td>docx-open-password</td>
</tr>
<tr>
<td>PPTX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any PPTX report.</td>
<td>NA</td>
<td>pptx-open-password</td>
</tr>
<tr>
<td>XLSX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any XLSX output file.</td>
<td>NA</td>
<td>xlsx-open-password</td>
</tr>
</tbody>
</table>

Create and Edit RTF Report Layout Templates

An RTF template is a rich text format file that contains the layout instructions to use when generating the report output. Use Microsoft Word with the Template Builder for Word add-in to design RTF templates.

Prerequisites
Install the Template Builder for Word add-in, and generate sample data.
Using Template Builder for Word

To modify an RTF template:

1. If you are editing an existing layout:
   a. Select your report in the business intelligence catalog and click Edit.
   b. In the report editor, click the Edit link of the layout to download the RTF file.
   If you are creating a new layout, skip this step.

2. Open the downloaded RTF template file in Microsoft Word. Or, if you're creating a new template, just open Microsoft Word.

3. Load the sample data that you generated.

4. Edit or create the layout template.

5. Save the file as Rich Text Format (RTF).

**eText Report Layout Templates: Explained**

An eText template is an RTF-based report template that is used for Electronic Funds Transfer (EFT) and Electronic Data Interchange (EDI). The template is applied to an input XML data file to create a flat text file that you transmit to a bank or other organizations. Use Microsoft Word to create or edit eText templates.

**File Format**

Because the output is for electronic communication, not printing, you must follow specific format instructions for exact placement of data on the template. You design eText templates using tables.

- Each record is represented by a table.
- Each row in a table corresponds to a field in a record.
- The columns of the table specify the position, length, and value of the field.

**Special Commands**

You must set up special handling of the data from the input XML file. This table describes the two levels of handling and where you declare the corresponding commands.

<table>
<thead>
<tr>
<th>Level</th>
<th>Example</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Character replacement</td>
<td>Declare global commands in separate setup tables.</td>
</tr>
<tr>
<td></td>
<td>Sequencing</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>Sorting</td>
<td>Declare functions in command rows, in the same table as the data.</td>
</tr>
</tbody>
</table>

**Upload the Layout Template File to the Report Definition**

If you're creating or editing a report layout using the layout editor, the layout is automatically saved to the report definition, so you can skip this step. For all other layout types, for example RTF, upload the template file to the report definition after you're done making layout changes.
Uploading the Template File

1. Select your report in the business intelligence catalog and click Edit.
2. In the report editor, click View a list.
3. In the table that lists the layouts, click Create.
4. Click Upload in Upload or Generate Layout.
5. In the Upload Template File dialog box:
   a. Enter a layout name.
   b. Browse for and select the layout template file that you created or edited.
   c. Select the template file type.
   d. Select the locale, which you can't change once the template file is saved to the report definition.
   e. Click Upload.
6. Save the report definition.

Configure Layout Settings for Reports

As part of creating or editing layout, you can set report properties related to layout. These settings determine, for example, which layouts users can choose from when viewing or scheduling the report. The settings apply only to your report.

Setting Layout Properties

1. Select your report in the business intelligence catalog and click Edit.
2. In the report editor, click View a list.
3. Set layout properties, some of which are described in this table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Formats</td>
<td>Depending on the requirements for a report, you may want to limit the output file formats (for example. PDF or HTML) that users can choose. The available output formats vary depending on the template file type.</td>
</tr>
<tr>
<td>Default Format</td>
<td>When multiple output formats are available for the report, the default output format is generated when users open the report in the report viewer.</td>
</tr>
<tr>
<td>Default Layout</td>
<td>When multiple layouts are available for the report, you must select a default layout to present it first in the report viewer.</td>
</tr>
<tr>
<td>Active</td>
<td>Active layouts are available for users to choose from when they view or schedule the report.</td>
</tr>
<tr>
<td>View Online</td>
<td>Select this check box so that layouts are available to users when they view the report. Otherwise, the layout is available only for scheduling the report.</td>
</tr>
</tbody>
</table>

4. Click Save Report.
Configure Item Attributes in a Report Template for the Item Structure Report

You can use this procedure to configure existing reports and view additional attributes in an Oracle Product Development Cloud report. This procedure can also be used to configure Oracle Product Information Management cloud reports.

Configuring item attributes for the Item Structure report involves downloading the item structure template, modifying it as required, and uploading the modified file to the application.

Note: Oracle recommends the use of the Mozilla Firefox browser for the following procedure. Download of the template is not recommended using the Google Chrome browser because of observed issues.

Download the Item Structure Template

You can download the item structure template as follows.

2. Select Item Structure Report and click More. The Oracle Business Intelligence Catalog is displayed.
   
   Note: Alternatively, you can sign in to the Business Intelligence Catalog and click the Browse Catalog icon to open the Oracle Business Intelligence Catalog.
5. Save the DefaultItemStructureReport.rtf file and name the template as Custom_ItemStructure.rtf.
6. Open Custom_ItemStructure.rtf in Microsoft Word. Ensure that the BI publisher plugin is enabled.

Edit the Item Structure Template

You can edit the item structure as follows.

1. In the Reports and Analytics window, click Shared Folders > Supply Chain Management > Product Management > Items > Structures.
2. Select Data Models and click Edit.
3. Select Properties and download the sample.xml file.
4. In Custom_ItemStructure.rtf, which is open in Microsoft Word, go to the BI publisher tab and upload the sample.xml file.
5. Insert columns by selecting both top header column and data column. In the fields, insert the values displayed in the following table:

<table>
<thead>
<tr>
<th>Header Column</th>
<th>Data Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>@effLabel</td>
<td>ITEM_EFF</td>
</tr>
<tr>
<td>@label</td>
<td>AML_DFF</td>
</tr>
<tr>
<td>@label</td>
<td>MPN_DFF</td>
</tr>
</tbody>
</table>
6. Set the BI expression for header and data column for each attribute type. Click the field name, and set the values displayed in the following table:

<table>
<thead>
<tr>
<th>Attribute Type</th>
<th>BI Property for Header Column</th>
<th>BI Property for Data Column</th>
</tr>
</thead>
</table>

7. Save the Custom_ItemStructure.rtf file.

**Note:** Ensure that the modified templates, such as Custom_ItemStructure.rtf, are backed up to the Custom folder, because the modified templates are deleted upon upgrade and must be manually copied from the Custom folder after each upgrade.

**Upload the Modified Item Structure File**
You can upload the modified item structure file as follows.

1. In the Item Structure Report window, click **Add New Layout**.
2. Click **Upload**. The Upload Template File dialog box displays.
3. Specify the following details and click **Upload**:
   a. Enter Layout Name.
   b. Specify the location of the modified Custom_ItemStructure.rtf file.
   c. Select **RTF Template** in the Type field.
   d. Select **English** in the Locale field.

**Verify the Changes**
You can verify the changes as follows.

1. Sign out from the application, and sign in as a product manager.
2. In the Product Development work area, create an item with the required data.
4. In the Item Structure Report dialog box, select a template, and click Submit. A process ID is generated and displayed in a confirmation message.
5. Copy the process ID.
6. Click the View Scheduled Processes task in the panel drawer. The View Scheduled Processes tab displays.
7. Enter the generated process ID in the Process ID field, and click the Search icon. The search results display in a table.
8. In the View Output column, click the Output icon for the item that you created, and select the Structure Report.xls file to view the report.

Data Models

Modify Data Models

A data model defines where data for a report comes from and how that data is retrieved. To create a modified data model if you need additional data not included in the existing model, you can copy and edit an existing data model in the Custom folder in the catalog. You must be a BI Administrator to create data models.

Create a Data Model

1. In the business intelligence (BI) catalog, click New and select Data Model in Published Reporting.
2. Optionally click the Properties node in the Data Model pane to set properties for the data model.
3. Click the Data Sets node in the Data Model pane to create or edit data sets, which determine where and how to retrieve data. Click New Data Set and select a data set type. It's best practice to use the BI repository as a data source, so you should select either:
   - SQL Query: To use a Query Builder tool to define what to use from the repository. Select Oracle BI EE as the data source.
   - Oracle BI Analysis: To use columns from a selected analysis.
4. Optionally, to limit the data included in the report output, click the Parameters node in the Data Model pane to define variables that users can set when they use the report. You can set parameters as mandatory if they're required, for example to filter data by a prompted value to improve query performance. These are indicated by an asterisk when you run the report. Mandatory report parameters are required before you can run a report using the View Data option or online, or schedule it.
   - Note: The order of parameters is important if there are job definitions defined for reports that use your data model. If you change the order in the data model, also update the job definitions.
5. Click Validate to view query and performance warnings.
6. Save your data model in Shared Folders > Custom.

Edit a Data Model

1. Copy the predefined data model.
   - Find the data model in the BI catalog and click Copy.
   - Paste within Shared Folders > Custom in a subfolder that has a folder path similar to the folder that stores the original data model.
c. For the data model you pasted, click **More**, and select **Edit**.

2. Optionally click the **Data Model** node in the Data Model pane to set properties for the data model.

3. Click the **Data Set** node in the Data Model pane to create or edit data sets.

Most predefined data models are of type SQL Query, and are set up to get application data from the following tables:

- **ApplicationDB_FSCM**: Financials, Supply Chain Management, Project Management, Procurement, and Incentive Compensation
- **ApplicationDB_CRM**: Sales
- **ApplicationDB_HCM**: Human Capital Management

4. Perform steps 4 through 6 from the preceding Create a Data Model task, as needed.

*Note:* External data sources aren’t supported.

**Related Topics**
- How You Set Up Reports to Run as Scheduled Processes
- How Data Is Structured for Analytics

### Validate Data Models: Explained

Data model validation errors and warnings help you correct data models, optimize queries, reduce stuck threads, and enhance the reporting performance.

When you create or edit a data model that’s created in the current or previous releases, if you click Validate, BI Publisher:

1. Checks the queries used for data sets, LOVs, and bursting definitions.
2. Generates the execution plan for SQL queries.
3. Displays a list of errors and warnings.

Take the required action based on the data model validation messages. See Data Model Validation Messages.

Note that when you upgrade BI Publisher from a previous release, the existing data models are marked as not validated.

**Data Model Validation Messages**

The data model validation messages can be of the following types:

- **Error** - You must resolve the data model errors if you want to use the data model to run a report.
- **Warning** - Make the correction suggested in the warning message. Reporting performance might get affected if you choose to run the report ignoring the warning.

The data model validation messages and their details are as follows:

<table>
<thead>
<tr>
<th>Validation Code</th>
<th>Validation Type</th>
<th>Message Type</th>
<th>Message</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM01_USE_OF_SELECT_STAR</td>
<td>Query</td>
<td>Warning</td>
<td>SQL query contains SELECT <em>. Use of '</em>' is restricted. Select the specific columns.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Validation Code</td>
<td>Validation Type</td>
<td>Message Type</td>
<td>Message</td>
<td>Limit</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>DM02_BIJBDC_NESTED_QUERY</td>
<td>Query</td>
<td>Warning</td>
<td>Data model contains nested BI JDBC queries. Linking logical queries is restricted. Use OTBI instead of BIP reports or remove the link between OBIEE data sets.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM03_MERGE_CARTESIAN_JOINS</td>
<td>Query</td>
<td>Warning</td>
<td>SQL query execution plan contains merge cartesian joins. Generate the explain plan for the SQL query and identify the merge cartesian joins. Add the required filters in the SQL query.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM04_NUM_BIND_VALUES_PER_PARAM</td>
<td>Runtime</td>
<td>Warning</td>
<td>Number of bind values per parameter more than the limit of {0} results in poor performance. Reduce the number of bind values.</td>
<td>100</td>
</tr>
<tr>
<td>DM05_NUM_COLUMNS_WITHOUT_PRUNING</td>
<td>Query</td>
<td>Warning</td>
<td>Number of columns in SELECT exceeds the limit of {0}. Select only the required columns and enable pruning.</td>
<td>30</td>
</tr>
<tr>
<td>DM06_NUM_COLUMNS_WITH_PRUNING</td>
<td>Query</td>
<td>Warning</td>
<td>Number of columns in SELECT exceeds the limit of {0}. Select only the required columns.</td>
<td>100</td>
</tr>
<tr>
<td>DM07_WHERE_CLAUSE_NOTIN_NOTEQUAL</td>
<td>Query</td>
<td>Warning</td>
<td>SQL query contains non-equal joins. Intermediate row spawning can cause performance issues. Replace non-equal joins with equal join or outer join.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM08_COLUMN_ALIAS_LENGTH</td>
<td>Query</td>
<td>Warning</td>
<td>Selected column length name exceeds the limit of {0}. Length of the column name must not be more than 15</td>
<td>15</td>
</tr>
<tr>
<td>Validation Code</td>
<td>Validation Type</td>
<td>Message Type</td>
<td>Message</td>
<td>Limit</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------</td>
<td>--------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>DM09_NUMBER_OF_INLINE_QUERY</td>
<td>Query</td>
<td>Warning</td>
<td>Number of inline or subquery exceeds the limit of (0). Remove the additional in-line select queries.</td>
<td>10</td>
</tr>
<tr>
<td>DM10_USE_OF_DUAL</td>
<td>Query</td>
<td>Warning</td>
<td>SQL query contains the FROM DUAL clause. SQL query contains too many DUAL clause. Avoid the usage of FROM DUAL clause.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM12_NUM_OF_CLOB_COLUMNS</td>
<td>Query</td>
<td>Warning</td>
<td>Number of LOB columns in SELECT exceeds the limit of (0). Select only the required columns.</td>
<td>2</td>
</tr>
<tr>
<td>DM14_DML_DDL_KEYWORD</td>
<td>Query</td>
<td>Error</td>
<td>Query contains DDL or DML keywords. Remove the DDL and DML keywords from the SQL query.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM15_NUM_GROUP_BREAKS</td>
<td>Structure</td>
<td>Warning</td>
<td>Number of group breaks on single data set exceeds the limit of (0). Remove multiple groups from the data set.</td>
<td>2</td>
</tr>
<tr>
<td>DM16_GROUP_FILTERS_CHECK</td>
<td>Structure</td>
<td>Warning</td>
<td>Data model contains group filters. Replace the group filters with the WHERE clause in the SQL query.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM17_DM_PROPERTY_CHECK</td>
<td>Runtime</td>
<td>Error</td>
<td>Data model property is invalid or contains invalid values. Specify the correct data model property and check the property value.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>DM18_FULL_TABLE_SCAN</td>
<td>Query</td>
<td>Warning</td>
<td>SQL query execution plan contains full table scans. Provide the required filters on</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
Define the Number of Rows in Tables

The data model used for a report can determine the number of rows to display in specific tables on the report. To change that number, you can edit a copy of the predefined data model.

Copying the Data Model

To copy the predefined data model used for the report:

1. Click Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), find the predefined data model used for the report.
4. Click Copy in the toolbar.
5. In the BI catalog, expand Shared Folders > Custom and follow the same file path as the predefined data model outside the Custom folder. Create the corresponding folder structure in Custom if it doesn’t exist.
Note: All reports using the predefined data model are automatically redirected to point to your copied data model in the Custom folder. This applies:
- To all reports, predefined or not
- Only if the copied data model has the same name and relative file path in Custom as the predefined data model

6. Click Paste in the toolbar.

Modifying the Data Model

To edit the copied data model:

1. In the BI catalog, find your copied data model.
2. Click Edit.
3. In the Data Model pane, in Data Sets, select the data set that provides data for the table in the report.
4. On the Diagram tab, click the Edit Selected Data Model icon.
5. In the Edit Data Set dialog box, see if the last line in the SQL Query field starts with FETCH FIRST, for example FETCH FIRST 500 ROWS ONLY. Not all data sets have this row limit that you can edit.
6. Change the number in that line to the number of rows you want displayed in the table, for example, FETCH FIRST 50 ROWS ONLY.
7. Click OK.
8. Click the Save icon.

Create a Search Parameter

You can use the Search type parameter to provide a box for entering search text and a search icon to search and list the values that match the search so that users can select from the values to search in a report.

Use the Search type parameter to find a value within a long list of values. You must create a LOV for the parameter before you define the Search type parameter.

To create a Search type parameter:

1. On the Data Model components pane, click Parameters, and then click Create new Parameter.
2. Enter a name for the parameter, select String from the Data Type list, and enter a default value for the parameter.
3. Select Search from the Parameter Type list.
4. Enter a label for the parameter in the Display Label field.
5. Select the LOV for the parameter from the List of Values list.
6. (Optional) Select Refresh other parameters on change.

Set Data Model Properties

Set data model properties to control query and extract processing and output.

Set Data Model Properties

1. Create or edit a data model.
2. Click the Properties node in the Data Model pane.
3. Set data model properties.
Create a Data Model for an SCM Report

This example shows how to create a data model for an Oracle Business Intelligence Publisher report. In this example, you create a data model using an SQL query to retrieve a list of items.

Create a Data Model

1. Navigate to the Reports and Analytics work area and click Browse Catalog to open the Oracle Business Intelligence Catalog.
2. On the OBI EE home page under Create, Published Reporting, click More and select Data Model.
3. On the Diagram tab, click New Data Set and select SQL Query.
4. In the New Data Set - SQL Query window, enter a name for your data model.
5. In the SQL Query field, enter the appropriate query. For example, you can use the following query:

```sql
select item.item_number "Item Num",
       item.inventory_item_id "Item ID",
       org.organization_code "Organization",
       to_char(item.creation_date, 'DD-MON-RRRR HH24:MI:SS') "Created",
       ic.item_class_code "Item Class",
       item.item_type "Item Type",
       item.current_phase_code "Lifecycle Phase Code",
       item.INVENTORY_ITEM_STATUS_CODE "Item Status",
       uom.unit_of_measure "Primary UOM",
       Decode(item.approval_status, 'A','Approved',
               'D','Draft', 'N','Not submitted for approval','R','Rejected','S','Submitted for approval','SCH','Scheduled') "Approval Status"
from egp_system_items_b item, inv_org_parameters org,
    egp_item_classes_b ic, inv_units_of_measure uom
where item.item_number like 'AS%' and
    item.template_item_flag = 'N' and item.organization_id = org.organization_id and item.item_catalog_group_id = ic.item_class_id
    and item.primary_uom_code = uom.uom_code order by item.creation_date desc, item.item_number
```
6. Click OK.
7. Click the Structure tab.
8. In the XML Tag Name field for the Item Number, replace the default value with ITEM_NUM, and replace the default value in the Display Name field with Item Number.
9. Repeat step 8 for other XML Tag names and Display Names as appropriate.
10. Click the Data tab.
11. On the Data tab, click View.
12. View the report structure and click Save As Sample Data.
13. Click OK.
14. Click Save.
15. In the Save As window, select My Folders, and enter SQL Query for Item List Data Model.

New Reports

Create Reports

Create a report when the predefined reports don’t provide the data you need. Or, if you want to use a predefined data model, and also want to change other aspects of the report other than layout. Save your report to Shared Folders > Custom in the business intelligence catalog. Saving content in the Custom folder is the only way to ensure that the content is maintained upon upgrade.

Creating a Report

1. Open the Reports and Analytics work area, and.
2. Click click New and select Report.
3. Select the data model to use as the data source for your report.

   Note: Be sure that the data model you select has been validated. If you select a data model that has not been validated or has errors, when the report is run it will error indicating that the data model has not been validated or has an invalid status. To override this warning for a report, select the Ignore Data Model Validation Error option in the report properties.

4. Continue with the wizard to create the report layout, or choose to use the layout editor and close the wizard.
5. Define the layout for the report.
6. Click the Properties button in the report editor to set specific formatting, caching, and processing options for your report, including overriding data model validation errors.

Setting Up Access

You or your administrator can:

- Create a job definition so that users can run your report as a scheduled process.
- Secure general access to your report and its job definition, if any.

Related Topics

- How You Set Up Reports to Run as Scheduled Processes
- Set Up Reports for Scheduling

Configurable Email Notifications

Overview of Configurable Email Notifications in SCM

As part of workflow tasks and based on the notification mode in BPM Worklist, the application automatically sends notifications to your users. For example, when someone submits a new item request for approval, the approver receives
an email notification with approval request. In the new item request workflow, you can use Oracle Business Intelligence (BI) Publisher to configure the content, layout, and style of the notifications.

The table shows the Supply Chain Management product that uses configurable email notifications, along with their associated features, and workflow task names.

<table>
<thead>
<tr>
<th>Product</th>
<th>Feature Name</th>
<th>Report or Notification Name</th>
<th>Workflow Task Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Hub</td>
<td>New Item Request</td>
<td>New Item Request Approval</td>
<td>NewItemRequestApprovalTask</td>
</tr>
</tbody>
</table>

**Note:** When you receive a workflow email notification, you can alternatively find the same notification by opening the Worklist: Notifications and Approvals work area or bell notification.

**Process Overview**

The process to generate email notifications is the same as generating other types of report output. The process involves various types of objects in the business intelligence catalog, including data models, subtemplates, style templates, and reports.

This figure shows how these objects work together to generate the output used for email notifications.

- **Data Sources:** Store the attributes and attribute values for business objects and transactions in the application (example of data sources being transaction tables)
- **Data Model:** Determines which attributes from data sources are available to be included in the email and how that data is retrieved
• **Subtemplate**: Provides common components, for example a branding logo and buttons, that can be reused in multiple reports

• **Style Template**: Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and color to use for headings

• **Report**: Contains a **layout template** that determines:
  - Which attributes appear in the email, from the data model used for the report
  - What the email looks like, leveraging components from the subtemplate and styles from the style template used for the report

• **HTML**: Is the output generated from the report

• **Email**: Is sent to users as part of a business flow, with the HTML output embedded in the email body

Each workflow task with configurable email notifications has a corresponding predefined report in the BI catalog.

**Email Modifications**

After you enable configurable email notifications, the predefined reports and related objects in the BI catalog work by default. The report-based notifications provide the same information as the standard notifications, but in a format optimized for mobile devices. If you need to modify the emails, you can edit copies of the predefined reports, data models, and subtemplate (but not the style template).

**Security**

To configure reports and data models for email notifications, you must have the Application Developer and the BI Administrator job role.

**Setup**

You must download and install the Template Builder for Word add-in.

**Best Practices for Layouts in Workflow Notifications**

Predefined workflow email notifications based on report layout templates all follow a general format. When you edit a copy of these layout templates in Microsoft Word, follow the predefined layout as closely as possible for consistency. Also keep in mind shared components and mobile considerations.

**General Structure**

In general, the email notifications contain the components shown in the following figure and table.
The callouts in this figure identify the different email components listed in the following table.

<table>
<thead>
<tr>
<th>Callout</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Notification header listing key attributes of the workflow task and the associated transaction.</td>
</tr>
<tr>
<td>2</td>
<td>Buttons for the primary actions to take on the task, such as Approve and Reject.</td>
</tr>
<tr>
<td>3</td>
<td>Notification body that usually includes transaction and line level details, displayed in tables or sets of attributes with corresponding values. The data model for the report restricts the total number of rows displayed in some of the tables. If the limit is exceeded, the table footer provides a link to the transaction details page, where users can view all the rows. To change this limit, you can edit a copy of the data model.</td>
</tr>
<tr>
<td>4</td>
<td>Approval history, including any attachments that users in the history uploaded for the task. You can't edit the approval history component.</td>
</tr>
<tr>
<td>5</td>
<td>Buttons for the primary actions again.</td>
</tr>
<tr>
<td>6</td>
<td>A link to the corresponding transaction page, and another link to the in-app notification.</td>
</tr>
</tbody>
</table>
When you modify email notifications, try to keep to this general structure and don't remove essential elements such as the action buttons. Likewise, don't change the styles in your layout template. The predefined style template should still apply to your email notification; don't edit a copy of the style template and apply that to your email.

To add components to your notification, for example another table, consider first downloading another style template from My Oracle Support. This template contains Quick Parts content that you can use in Word when you do more advanced work on layout templates. For example, from the Quick Parts gallery, you can select and add the table that is consistent in format with predefined tables already on your notification.

**Shared Components**

A predefined subtemplate in the business intelligence (BI) catalog applies to all predefined layout templates for email notifications. The subtemplate contains components that are shared among the notifications, for example:

- Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body
- Action buttons
- Links at the end of the notification, one to the corresponding transaction page, and another to the in-app notification

When you make a copy of a predefined layout template to edit, the copy automatically inherits the same predefined subtemplate. To edit these shared components, make a copy of the predefined subtemplate, edit the copied version, and apply it to your own layout templates.

**Mobile Considerations**

Because users can view the workflow notifications on mobile devices, always consider mobile first and keep the notifications as simple as possible. For example:

- Don't put too much content horizontally, such as too many columns in tables.
- Keep all text, including attributes and column headings, as short as possible.
- Center align lists of attributes and their values, if they appear outside tables.

Make sure to test your email notifications on mobile devices.

**Modify New Item Request Email Notification Template**

Before modifying workflow email notifications, it's recommended that you familiarize yourself with BI Publisher. This will improve your ability to change your notifications by formatting emails to meet your business requirements. Also review the My Oracle Support (MOS) topic, Configurable Email Notifications: Implementation Considerations (Doc ID 2215570.1).

With BI Publisher-based email notifications you:

- Use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word, rather than the layout editor or other tools available for creating and editing report layout.
- Edit a copy of predefined layout templates, rather than creating reports or layout templates.
To modify the email notification template:

1. Navigate to the BI Publisher.
2. Click Catalog Folders.
3. Navigate to the following folder:
   Shared Folders/Supply chain Management/Product Management/Items/New Item Requests/
5. In New Item Request Approval Email Notification Template, click Properties and select English as the default locale. This is to ensure that the template remains intact. Click OK and click Save.
6. Modify the template as required.
7. To upload the template, navigate to:
   Shared Folders/Supply chain Management/Product Management/Items/New Item Requests/
9. Select the template you modified in rich text format and click OK.
10. For localization:
    o In New Item Request Approval Email Notification Report, click Properties.
    o In Translations, click Extract Translation to download the translation.xlf file.
    o Update the translation.xlf file with required language and upload it to the respective language.

Add a Branding Logo and Change Other Shared Components in Workflow Notifications

A predefined subtemplate contains common components for all workflow notifications based on predefined report layouts. For example, the subtemplate has a place for you to add a branding logo, which would appear at the beginning of email notifications. You can modify other shared components so that the same changes apply to your notifications. For example, for email notifications, you can also change the text on action buttons, or the text of the links that appear at the end of emails.

Note:
- You must edit a copy of the subtemplate in the Custom folder of the business intelligence (BI) catalog. Don’t directly update the predefined subtemplate.
- The exact steps can vary depending on your version of Microsoft Word.

Modifying Shared Components in the Subtemplate

To edit a copy of the predefined subtemplate that contains the shared components:

1. Click Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.

   If you’re not using the Customize option:
   a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
   b. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates. Create a Templates folder in this location if it doesn’t exist.
c. Click **Paste** in the toolbar.

d. Click the **Edit** link for the copied subtemplate.

All reports using the predefined subtemplate are automatically redirected to point to your subtemplate in the Custom folder. This applies:

- To all reports, predefined or not
- No matter if you copy and paste the subtemplate or use the Customize option
- Only if your subtemplate has the same name and relative file path within Custom as the predefined subtemplate

5. In the Templates section, click the link in the Locale column.
6. Save the subtemplate .rtf file to your computer.
7. Open the .rtf file with Microsoft Word.

- To add a logo, insert your own image in the subtemplate.
- To change button or link text, edit the text accordingly. Make the same edits wherever that button or link text appears in the subtemplate.

!important Caution: To ensure that your layout templates reflect these changes without additional rework, don't edit any other text in the subtemplate .rtf file.

8. Update Word options to ensure that existing links remain intact in the subtemplate.

   a. Click **File > Options > Advanced**.
   b. In the Word Options dialog box, click **Web Options** in the General section.
   c. In the Web Options dialog box, open the Files tab.
   d. Deselect the **Update links on save** check box.
9. Save your changes in Word.

### Uploading the Modified Subtemplate

To upload your subtemplate to the BI catalog:

1. In the BI catalog, expand **Shared Folders > Custom > Common Content > Templates**.
2. Click **Edit** for Workflow Notification Subtemplate.
3. In the Templates section, click the **Upload** icon.
4. Select your modified .rtf subtemplate and a locale, and click **OK** to overwrite the original subtemplate.

### Related Topics
- **Best Practices for Layouts in Workflow Notifications**

### Use Quick Parts for Workflow Notifications

Use the Quick Parts feature in Microsoft Word to easily insert reusable pieces of formatted content. When you edit copies of predefined report layout templates for workflow notifications in Word, you can add predefined Quick Parts content to your .rtf file. For example, you can insert a table in a format that's consistent with predefined notifications. The predefined Quick Parts content is available in a **style template** .dotx file on My Oracle Support.

Note: The exact steps can vary depending on your version of Microsoft Word.
Prerequisites

To get the predefined Quick Parts content into your Quick Parts gallery:

2. Download the .dotx file and save it to your Microsoft Word template folder, for example C:\Users\<username>\AppData\Roaming\Microsoft\Templates.

Also, to preview your layout template changes before uploading the .rtf file back to the business intelligence (BI) catalog:

- Generate sample report data from the data model for the report that you’re editing.
- Download a local copy of the subtemplate that applies to the layout template.

Adding Quick Parts Content to Workflow Notifications

To insert content from the Quick Parts gallery into a layout template:

1. In the BI catalog, find the predefined report with the layout template that you want to modify.
2. For the report, click More and select Customize.

   If you’re not using the Customize option:
   
   a. Copy the predefined report and paste it in an appropriate subfolder within the Custom folder.
   b. Click the Edit link for the copied report.

3. Click Edit for the layout template to insert Quick Parts content into, and save the .rtf file to your computer with a new file name.
4. Open the .rtf file with Microsoft Word.
5. Put your cursor where you want to insert new content.
6. From the Insert tab on the ribbon, click Quick Parts within the Text group, and select the component to insert.
7. Edit the inserted component as needed and add any other components.
8. Save your changes in Word.

Previewing the Layout Template Changes

To preview your edits before uploading your layout template to the BI catalog:

1. On the ribbon, open the BI Publisher tab and click Sample XML within the Load Data group to import sample data from the data model. Skip this step if you already loaded sample data.
2. At the beginning of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change "<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>" TO "<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>".
3. From the BI Publisher tab on the ribbon, click HTML in the Preview group.
4. If the preview reflects your changes as expected, then change the path back to the original location.
5. Save your changes in Word.

Uploading the Modified Layout Template

To upload your layout template to the BI catalog after previewing the changes:

1. Back in the BI catalog, click Edit for the report within the Custom folder, if that page isn’t still open.
2. Click the View a list link.
3. Click the Create icon on the table toolbar.
4. In the Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, click Delete for the layout template that you downloaded earlier.
7. Click the **Save Report** icon.

**Related Topics**
- Configurable Email Notifications: Implementation Considerations
- Best Practices for Layouts in Workflow Notifications

## Preview Changes to Layout Templates for Workflow Notifications

To modify workflow notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word. Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the notifications sent to users.

---

**Note:** The exact steps can vary depending on your version of Microsoft Word.

### Prerequisites

- Generate sample report data from the data model used for the report, and save the .xml file to your computer.
- Download a local copy of the subtemplate that applies to your own report layout template:
  1. In the BI catalog, expand **Shared Folders > Custom > Common Content > Templates** if you're using a modified subtemplate, or **Shared Folders > Common Content > Templates** for the predefined subtemplate.
  2. Click **Edit** for Workflow Notification Subtemplate.
  3. In the Templates section, click the link in the Locale column.
  4. Save the subtemplate .rtf file to your computer.

### Previewing Output

To generate sample output from a local layout template:

1. Open your .rtf report layout template in Microsoft Word and make your edits.
2. On the ribbon, open the BI Publisher tab and click **Sample XML** within the Load Data group.
3. Select the .xml file you downloaded to import sample data from the data model.
4. At the beginning of your .rtf document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>`.
5. From the BI Publisher tab on the ribbon, click **HTML** in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the BI Publisher tab on the ribbon, click **Validate Template** in the Tools group.
8. Also in the Tools group, click **Check Accessibility**.
9. Save your changes in Word.

**Related Topics**
- Best Practices for Layouts in Workflow Notifications
7 Analytics and Reports Management

Manage Folders

Create Folders
You manage analyses and reports in the business intelligence catalog, where you create folders to organize them.

Creating Folders
Follow these steps:

1. In the catalog, navigate to the desired location of the new folder in the Folders pane.
2. In the catalog toolbar, click New, and select Folder.
3. In the New Folder dialog box, enter the folder name, and click OK.

Addressing Automatically Created Folders
If conflicts are detected during upgrade, folders named backup_nnn are automatically created in the catalog. After reviewing and resolving any conflicts, Oracle recommends that you manually delete the backup folders from the catalog. You can contact your help desk to request an automated removal if you have a large number of folders to delete.

Set Folder Permissions and Attributes
Business intelligence catalog folder properties control folder permissions and other attributes. You can access the properties of user objects or the Custom folder and any of its subfolders in the catalog to perform tasks such as viewing system information or changing attributes or ownership. All other users can only access and modify the properties of the objects that they create or own.

Setting Folder Properties
Follow these steps:

1. In the catalog, select the Shared Folders > Custom folder or its subfolder you want to assign properties to.

   Caution: Don't modify permissions on predefined catalog objects. Saving content in the Custom folder is the only way to ensure that the content is maintained upon upgrade.

2. In the Tasks pane, click Properties.
3. In the Properties dialog box, select any of the options in the Attributes section:
   - Hidden: Specifies that the object is hidden.
   - System: Specifies that the object is a system object.
   - Read Only: Specifies that the object is read-only.
Do Not Index: Excludes the object from the index used by the full-text catalog search. Excluded objects do not display in the results of any full-text catalog search; the object can still be found using the basic catalog search.

4. Use the Ownership section to take ownership of a folder or object in the catalog. This area displays only if the proper privileges were assigned to the user, group, or role. Note that the owner of an object or folder can't automatically access the object or folder.
   - Set ownership of this item: Click to become the owner of the folder or object.
   - Set ownership of this item and all sub items: Click to become the owner of the folder and any sub folders or sub items contained within the item. For example, if you click this link for a dashboard folder, then you take ownership of all of the dashboard's components.

Related Topics
- What happens to modified analytics and reports when an update is applied

Set Folder Permissions
You can assign permissions on folders and other objects.

Accessing and Setting Permissions
You can set permissions or change ownership for any catalog object or folder. Nonadministrative users can access and modify the permissions of the objects that they create or own.

To set folder permissions:
1. In the catalog, select the folder or object.
2. In the Tasks pane click Permissions.
3. In the Permissions dialog box, the owner and any other users, roles, or groups with permissions are listed in the Permissions list. To add a user or role, click Add users/roles in the toolbar and search for users or roles to add them to the Selected Members list in the Add Application Roles, Catalog Groups and Users dialog box. To delete a user or role, select the account or role in the Permissions list and click Delete selected users/roles.
4. In the Permissions list, to set ownership for a user, select Custom in the Permissions list for the account, then select Set Ownership in the Custom Permissions dialog box and click OK. You can also select the Owner option for the user or role.
5. Use the Permissions list to set permissions for the object. Object permissions vary by object.
6. Use the Apply permissions to sub-folders option to assign permissions to the folder's subfolders, and the Apply permissions to items within a folder to assign them to objects in the folder but not to subfolders.

Manage Predefined Catalog Permission
You may want to remove access to predefined catalog folders so that those associated with offerings you don't use aren't displayed. You can hide the entire predefined catalog or selectively display root catalog folders for offerings, which are controlled by the Custom BI Web cat Reporting Duty role and associated roles for each offering.

Using roles, you can manage folder access in a number of ways, depending on requirements and previous modifications you have made.
- Remove duty roles for top-level folders from the Custom BI Web cat Reporting Duty role so that all users see a subset of the predefined catalog. Leave roles only for the offerings you want to retain access for.
• Delete all catalog reporting duty roles from the Custom BI Web cat Reporting Duty role to hide the entire predefined catalog and display only /Shared/Custom folders. For example, you can remove BI catalog access for external users such as partners who have no access to reporting.

• Delete all catalog reporting duty roles from the Custom BI Web cat Reporting Duty role. Also, add catalog reporting duty roles to a new or existing job role to allow job roles with BI access to have default access to the predefined catalog. For example, by default, Financial job roles have access to Financial reporting content but Human Capital Management job roles don't have access to the predefined HCM BI catalog. You can grant the Human Capital Management Folder Reporting Duty role to new job roles to allow access to predefined HCM reports.

**Hide Predefined Catalog Folders**

All authenticated users have the Custom BI Web cat Reporting Duty role, which inherits all of the folder reporting roles that determine access and visibility of root level catalog folders. Administrators with IT Security Manager privileges can hide predefined folders by removing their associated roles from the duty role.

1. Open the Security Console.
3. In the search results, click **Actions > Edit Role**.
4. Click **Next** to navigate to the Role Hierarchy step.
5. To hide all folders, remove all of the roles from the hierarchy. Leave any roles for offerings you want to retain access for.
7. Go to Oracle BI and click **Administration**. In the Maintenance and Troubleshooting section, select **Reload Files and Metadata** to refresh the BI cache.

**BI Reporting Roles**

This table shows the mapping between shared root catalog folders, folder reporting roles, and job roles.

<table>
<thead>
<tr>
<th>Catalog Folder</th>
<th>Duty Role</th>
<th>Duty Role Name</th>
<th>Associated Job Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Shared/Common Content</td>
<td>BI_COMMON_CONTENT_REPORTING_DUTY</td>
<td>Common Content Folder Reporting Duty</td>
<td></td>
</tr>
<tr>
<td>/ Shared/ Customer Data Management</td>
<td>BI_CDMREPORTING_DUTY</td>
<td>Customer Data Management Folder Reporting Duty</td>
<td></td>
</tr>
<tr>
<td>/ Shared/ Enterprise Contracts</td>
<td>BI_OKC_REPORTING_DUTY</td>
<td>Enterprise Contracts Folder Reporting Duty</td>
<td>ORA_OKC_CUSTOMER_CONTRACT_ADMINISTRATOR_JOB ORA_OKC_CUSTOMER_CONTRACT_MANAGER_JOB ORA_OKC_CUSTOMER_CONTRACT_TEAM_ABSTRACT ORA_OKC_ENTERPRISE_CONTRACT_ADMINISTRATOR_JOB ORA_OKC_ENTERPRISE_CONTRACT_MANAGER_JOB ORA_OKC_ENTERPRISE_CONTRACT_TEAM_ABSTRACT</td>
</tr>
</tbody>
</table>

---

**Oracle SCM Cloud**

Creating and Administering Analytics and Reports for SCM

**Chapter 7**

**Analytics and Reports Management**

---

Page 103
<table>
<thead>
<tr>
<th>Catalog Folder</th>
<th>Duty Role</th>
<th>Duty Role Name</th>
<th>Associated Job Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ Shared/ Extension</td>
<td>BI_EX__REPORTING__DUTY</td>
<td>Extension Folder Reporting Duty</td>
<td>MEMBER_ABSTRACT ORA_OKC_SUPPLIER_CONTRACT_ADMINISTRATOR_JOB ORA_OKC_SUPPLIER_CONTRACT_MANAGER_JOB ORA_OKC_SUPPLIER_CONTRACTTEAM_MEMBER_ABSTRACT</td>
</tr>
<tr>
<td></td>
<td>/ Shared/ Financials</td>
<td>BI_FIN__REPORTING__DUTY</td>
<td>Financials Folder Reporting Duty</td>
</tr>
<tr>
<td></td>
<td>/Shared/Higher Education</td>
<td>BI_HED__REPORTING__DUTY</td>
<td>Higher Education Folder Reporting Duty</td>
</tr>
<tr>
<td>Catalog Folder</td>
<td>Duty Role</td>
<td>Duty Role Name</td>
<td>Associated Job Roles</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------</td>
<td>-------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/Shared/Human Capital Management</td>
<td>BI_HCM_REPORTING_DUTY</td>
<td>Human Capital Management Folder Reporting Duty</td>
<td>MANAGER_JOB ORA_HEY_STUDENT_SUPPORT_ADVISOR_JOB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>By default, predefined HCM job roles have no access to the predefined content.</td>
</tr>
<tr>
<td>/ Shared/ Incentive Compensation</td>
<td>BI_IC_REPORTING_DUTY</td>
<td>Incentive Compensation Folder Reporting Duty</td>
<td>ORA_CN_INCENTIVE_COMPENSATION_ANALYST_JOB ORA_CN_INCENTIVE_COMPENSATION_MANAGER_JOB ORA_CN_INCENTIVE_COMPENSATION_PARTICIPANT_ABSTRACT ORA_CN_INCENTIVE_COMPENSATION_PARTICIPANT_MANAGER_ABSTRACT ORA_CN_INCENTIVE_COMPENSATION_PLAN_ADMINISTRATOR_JOB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>/ Shared/ Loyalty</td>
<td>BI_LOY_REPORTING_DUTY</td>
<td>Loyalty Folder Reporting Duty</td>
<td>ORA_LOY_LOYALTY_MARKETING_MANAGER_JOB ORA_LOY_LOYALTY_PROGRAM_ADMINISTRATOR_JOB</td>
</tr>
<tr>
<td>/ Shared/ Manufacturing</td>
<td>BI_MFG_REPORTING_DUTY</td>
<td>Manufacturing Folder Reporting Duty</td>
<td>ORA_CSE.Asset_ADMINISTRATOR_JOB</td>
</tr>
<tr>
<td>/ Shared/ Marketing</td>
<td>BI_MKT_REPORTING_DUTY</td>
<td>Marketing Folder Reporting Duty</td>
<td>ORA_MKL.SALES_LEAD_QUALIFIER_JOB ORA_MKT_CORPORATE_MARKETING_MANAGER_JOB ORA_MKT_MARKETING_ANALYST_JOB ORA_MKT_MARKETING_MANAGER_JOB ORA_MKT_MARKETING_OPERATIONS_MANAGER_JOB ORA_MKT_MARKETING_VP_JOB</td>
</tr>
<tr>
<td>/ Shared/ Partner</td>
<td>BI_ZPM_REPORTING_DUTY</td>
<td>Partner Folder Reporting Duty</td>
<td>ORA_ZPM_CHANNEL_ACCOUNT_MANAGER_JOB ORA_ZPM_CHANNEL_ADMINISTRATOR_JOB ORA_ZPM_CHANNEL_OPERATIONS_MANAGER_JOB ORA_ZPM_CHANNEL_PARTNER_MANAGER_JOB ORA_ZPM_CHANNEL_PARTNER_</td>
</tr>
<tr>
<td>Catalog Folder</td>
<td>Duty Role</td>
<td>Duty Role Name</td>
<td>Associated Job Roles</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------</td>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/ Shared/ Procurement</td>
<td>BI_PRC_REPORTING_DUTY</td>
<td>Procurement Folder Reporting Duty</td>
<td>ORA_AP_ACCOUNTS_PAYABLE_MANAGER_JOB ORA_AP_ACCOUNTS_PAYABLE_SPECIALIST_JOB ORA_AP_ACCOUNTS_PAYABLE_SUPERVISOR_JOB ORA_PO_BUYER_JOB ORA_PO_PROCUREMENT_APPLICATION_ADMIN_JOB ORA_PO_PROCUREMENT_INTEGRATION_SPECIALIST_JOB ORA_PO_PURCHASE_ANALYSIS_ABSTRACT ORA_POQ_SUPPLIER_QUALIFICATION_DISCRETIONARY ORA_POR_PROCUREMENT_REQUESTER_ABSTRACT ORA_POZ_SUPPLIER_ADMINISTRATOR_ABSTRACT ORA_POZ_SUPPLIER_MANAGER_ABSTRACT</td>
</tr>
<tr>
<td>/ Shared/ Projects</td>
<td>BI_PRJ_REPORTING_DUTY</td>
<td>Projects Folder Reporting Duty</td>
<td>ORA_OKC_CUSTOMER_CONTRACT_ADMINISTRATOR_JOB ORA_OKC_CUSTOMER_CONTRACT_MANAGER_JOB ORA_OKC_CUSTOMER_CONTRACT_TEAM_MEMBER_ABSTRACT ORA_OKC_ENTERPRISE_CONTRACT_ADMINISTRATOR_JOB ORA_OKC_ENTERPRISE_CONTRACT_MANAGER_JOB ORA_OKC_ENTERPRISE_CONTRACT_TEAM_MEMBER_ABSTRACT ORA_PJF_GRANTS_ACCOUNTANT_JOB ORA_PJF_GRANTS_ADMINISTRATOR_JOB ORA_PJF_GRANTS_DEPARTMENT_ADMINISTRATOR_JOB ORA_PJF_PROJECT_ACCOUNTANT_JOB ORA_PJF_PROJECT_ADMINISTRATOR_JOB ORA_PJF_PROJECT_BILLING_SPECIALIST_JOB ORA_PJF_PROJECT_EXECUTION_ABSTRACT</td>
</tr>
<tr>
<td>Catalog Folder</td>
<td>Duty Role</td>
<td>Duty Role Name</td>
<td>Associated Job Roles</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>----------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/Shared/Public Sector</td>
<td>BI_PSC_REPORTING_DUTY</td>
<td>Public Sector Folder Reporting Duty</td>
<td>ORA_PSC_AGENCY_STAFF_ABSTRACT ORA_PSC_BUILDING_INSPECTOR_JOB ORA_PSC_BUSINESS_ANALYST_JOB ORA_PSC_CHIEF_BUILDING_OFFICER_JOB ORA_PSC_ECONOMIC_DEV_OFFICER_JOB ORA_PSC_FINANCE_ADMIN_JOB ORA_PSC_INSPECTIONS_SUPERVISOR_JOB ORA_PSC_PERMIT_TECHNICIAN_JOB ORA_PSC_PERMITS_APPLICATION_ADMINISTRATOR_JOB ORA_PSC_PERMITS_SUPERVISOR_JOB ORA_PSC_PLAN_COORDINATOR_JOB ORA_PSC_PLAN_REVIEWER_JOB ORA_PSC_PRINCIPAL_PLANNER_JOB ORA_PSC_SYSTEM_ADMINISTRATOR_JOB</td>
</tr>
<tr>
<td>/Shared/Risk Management</td>
<td>BI_GRC_REPORTING_DUTY</td>
<td>Risk Management Folder Reporting Duty</td>
<td>ORA_GTG_APPLICATION_ACCESS_AUDITOR_JOB ORA_GTG_APPLICATION_CONTROL_MANAGER_JOB ORA_GTG_COMPLIANCE_MANAGER_JOB ORA_GTG_ENTERPRISE_RISK_AND_CONTROL_MANAGER_JOB ORA_GTG_RISK_MANAGEMENT_AUDITOR_JOB ORA_GRTR_USER_ACCESS_CERTIFICATION_MANAGER_JOB</td>
</tr>
</tbody>
</table>
| /Shared/Sales          | BI_ZBS_REPORTING_DUTY         | Sales Folder Reporting Duty                         | ORA_ZBS_SALES_ADMINISTRATOR_JOB ORA_
<table>
<thead>
<tr>
<th>Catalog Folder</th>
<th>Duty Role</th>
<th>Duty Role Name</th>
<th>Associated Job Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>/ Shared/ Service</td>
<td>BI_SVC_ REPORTING_ DUTY</td>
<td>Service Folder Reporting Duty</td>
<td>ORA_CS0_KNOWLEDGE_ANALYST_JOB ORA_CS0_KNOWLEDGE_MANAGER_JOB ORA_SVC_CUSTOMER_SERVICE_MANAGER_JOB ORA_SVC_CUSTOMER_SERVICE_REPRESENTATIVE_JOB ORA_SVC_HUMAN_RESOURCE_HELP_DESK_ADMINISTRATOR_JOB ORA_SVC_HUMAN_RESOURCE_HELP_DESK_AGENT_JOB ORA_SVC_HUMAN_RESOURCE_HELP_DESK_MANAGER_JOB ORA_SVC_INTERNAL_HELP_DESK_ADMINISTRATOR_JOB ORA_SVCINTERNAL_HELP_DESK_AGENT_JOB ORA_SVC_INTERNAL_HELP_DESK_MANAGER_JOB ORA_ZBS_SALES_ADMINISTRATOR_JOB ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB</td>
</tr>
<tr>
<td>/ Shared/ Subscription Management</td>
<td>BI_OSS_ REPORTING_ DUTY</td>
<td>Subscription Management Folder Reporting Duty</td>
<td>ORA_OSS_SUBSCRIPTION_SPECIALIST_JOB</td>
</tr>
<tr>
<td>/Shared/Supply Chain Management</td>
<td>BI_SCM_ REPORTING_ DUTY</td>
<td>Supply Chain Management Folder Reporting Duty</td>
<td>ORA_ACD_PRODUCT DESIGN_ENGINEER_JOB ORA_ACD_PRODUCT DESIGN_MANAGER_JOB</td>
</tr>
<tr>
<td>Catalog Folder</td>
<td>Duty Role</td>
<td>Duty Role Name</td>
<td>Associated Job Roles</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>/ Shared/ Functional Setup</td>
<td>BI_FSM_REPORTING_DUTY</td>
<td>Functional Setups Folder Reporting Duty *Not inherited by Custom BI Web cat Reporting Duty</td>
<td>ORA_ASM_APPLICATION_IMPLEMENTATIONCONSULTANT_JOB</td>
</tr>
</tbody>
</table>
## Predefined Catalog Lockdown

If you try to modify the predefined catalog content including folder permissions, you get an alert indicating that you’re not allowed to modify content and asking that you save your own content in the /Shared/Custom folder.

Here are a few things to know about catalog folders:

- You must save all modified content in the /Shared/Custom folder or in new folders under the /Shared folder.
- Existing modified content in the /Shared/Custom folder or custom folders under the /Shared folder and their subfolders is preserved. If you have modified the content in the predefined catalog folders, all changes are lost during any upgrade. To preserve content, archive your catalog content and unarchive it in the Shared/Custom folder after upgrade.
- All existing content in top-level folders under the /Shared folder is preserved.
- You can’t change folder or object permissions on the predefined catalog folders or content. For example, you can’t change folder permissions to hide folders or objects.

### Related Topics
- Business Intelligence Catalog
- Role Inheritance
- Move Analytics

## Briefing Books

### Create Briefing Books

Use briefing books to hold a collection of analytic snapshots. These snapshots give you a picture of what’s going on at the time the analytic is added, or downloaded or reran. You can download briefing books as PDFs or MHTML to view, print, or share. The PDF file includes a table of contents. Briefing books are stored in the business intelligence (BI) catalog.

### Add Content to New Briefing Books

1. Open the Reports and Analytics work area.
2. Click **Browse Catalog**.
3. Select your analytic, then click **More** and select **Add to Briefing Book**.
   
   Or, find your dashboard and click **Open**.
   
   a. Go to the dashboard page you want to add.
   b. Click the **Page Options** button and select **Add to Briefing Book**.
4. Indicate if you want the analytic results refreshed whenever the briefing book is downloaded or rerun.
5. Click **Browse**.
6. Name your briefing book and save it in **My Folders**.

### Add Content to Existing Briefing Books
1. Open the Reports and Analytics work area.
2. Click **Browse Catalog**.
3. Select your analysis, then click **More** and select **Add to Briefing Book**.
   Or, find your dashboard and click **Open**.
   a. Go to the dashboard page you want to add.
   b. Click the **Page Options** button and select **Add to Briefing Book**.
4. Indicate if you want the analytic refreshed whenever the briefing book is downloaded or rerun.

### Download and Edit Briefing Books
1. Open the Reports and Analytics work area.
2. Click **Browse Catalog** to locate your briefing book.

**Related Topics**
- Reports and Analytics Work Area and Panel Tab

### Schedule Analytics and Reports

#### How You Set Up Reports to Run as Scheduled Processes
You can create a **job definition** for predefined or modified *reports* so that users can run them as **scheduled processes**. Use the Define Custom Enterprise Scheduler Jobs task in the Setup and Maintenance **work area** to create job definitions. Otherwise, users can open reports (which are set up to be run online) through the Reports and Analytics work area or panel tab, or open and schedule them from the **business intelligence catalog**.

#### General Job Definition Information
This table describes the general information to enter for your job definition.

<table>
<thead>
<tr>
<th>Field</th>
<th>What You Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Type</td>
<td>BIPJobType</td>
</tr>
<tr>
<td>Report ID</td>
<td>The path to the report in the catalog, starting with the folder beneath Shared Folders, for example: Custom/ &lt;Family Name&gt;/ &lt;Product Name&gt;/ &lt;Report File Name&gt;.xdo. Make sure to include the .xdo extension for the report definition.</td>
</tr>
<tr>
<td>Default Output</td>
<td>A default output format.</td>
</tr>
</tbody>
</table>
### Parameters
You can define parameters to be available to users when they submit scheduled processes based on your job definition. When users run the scheduled process, the values they enter for the parameters:

- Are passed to the *data model* that the report is using.
- Determine the data to be included in the report.

The parameters that you define must be in the same order as parameters in the data model. For example, the data model has parameters in this order:

- P_START_DATE
- P_END_DATE
- P_CURRENCY

You create parameters as follows:

- Start Date
- End Date
- Currency

**Note:** Because you define parameters using the list of values sources from the Define Custom Enterprise Scheduler Jobs task, you should not define lists of values in the data model.

### User Property
The only user property you must define is `EXT_PortalContainerWebModule`. Only lists of values associated with the application that you select are made available for parameters in this job definition.

### Related Topics
- Modify Data Models
- Create Reports

### Set Up Reports for Scheduling
You can set up reports as *scheduled processes*, which means users can submit them from the Scheduled Processes and other work areas. If you want users to also submit these scheduled processes from the Reports and Analytics work area and panel tab, then you must configure properties for the corresponding reports.

### Enabling a Report for Scheduling
To enable scheduling in the Reports and Analytics work area and panel tab:

1. In the Reports and Analytics work area or panel tab, edit the report in the *business intelligence catalog*.
2. Click *Properties*.
3. On the General tab in the Properties dialog box, enter the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>What You Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Oracle SCM Cloud
Creating and Administering Analytics and Reports for SCM

Chapter 7
Analytics and Reports Management

112
Field | Value
--- | ---
Enterprise Scheduler Job Package Name | The path for the job definition, for example: / oracle/ apps/ ess/<product family>/ <product>/ <business area>/ Jobs
Enterprise Scheduler Job Definition Name | The job definition name (not display name), for example: ABCDEFG

### Related Topics
- Set Up the Reports and Analytics Panel Tab
- How You Access and Modify Report Components

### Schedule Analytics and Briefing Books

*Analytics* and *briefing books* can run based on a schedule that you define. You can set up other automated tasks, for example to deliver results to specific recipients, send notifications, or to generate a list of changes implemented today using the CURRENT_DATE repository variable. You create what's called an agent to set this all up for an *analysis*, *dashboard*, or briefing book. The agent itself is saved as an object in the *business intelligence (BI) catalog*. Agents can run based on a schedule that you define. You can set up other automated tasks, for example to deliver results to specific recipients, send notifications, or to generate a list of changes implemented today using the CURRENT_DATE repository variable. You create what's called an agent to set this all up for an *analysis*, *dashboard*, or briefing book. The agent itself is saved as an object in the *business intelligence (BI) catalog*. Agents can

### Creating an Agent

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click the **Browse Catalog** button.
3. Click **New** and select **Agent** in the **Actionable Intelligence section**.
4. Ensure that you enter information on the Delivery Content tab to specify the analysis, dashboard, or briefing book to run.
5. Save the agent in **My Folders**.

*Note:* To edit an agent, browse the BI catalog to find the agent.

### Related Topics
- Reports and Analytics Work Area and Panel Tab

### Schedule Reports

*Reports* can run based on a schedule that you define. You can set up other automated tasks, for example to deliver results to specific recipients or send notifications. You submit a report with the schedule and criteria for other automated tasks defined.

If a report is set up as a *scheduled process*, you submit the process as you would any scheduled process. You can schedule them from:

- Any work area where there is a link to the report.
• The Scheduled Processes work area, where you can submit all processes that you have access to.
• The Reports and Analytics work area or panel tab, if the report is set up for submission from there.

Submitting a Report or Scheduled Process
Follow these steps:
1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the report.
2. Click the name of your report.
3. Click Schedule if the option is there. The report is set up as a scheduled process.
   a. Enter any parameters to avoid unnecessarily large results.
   b. Click Advanced to enter a schedule, deliver results to a specific destination (including e-mail or printer), or define criteria for sending notifications.
4. If you don't see Schedule, then click View.
   a. Click the Actions button for the report and select Schedule.
   b. Enter information similar to step 3.

Related Topics
• Overview of Scheduled Processes
• Reports and Analytics Work Area and Panel Tab
• View Status and Other Details for Scheduled Processes
• Submit Scheduled Processes and Process Sets

Add Analyses to Application Pages

Add an Analysis to a Dashboard
This example shows how to add an analysis to a dashboard. You can add analyses to some of the pages that you can edit.

Caution: Make sure that the analysis isn't querying against a large volume of records. If it is, then the page can take a long time to open after you add the analysis.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which analysis do you want to add?</td>
<td>Any analysis that you choose</td>
</tr>
<tr>
<td>Do you have to change the layout of the page?</td>
<td>No.</td>
</tr>
<tr>
<td>Do you want all or only one view of the analysis?</td>
<td>All views.</td>
</tr>
</tbody>
</table>
Adding an Analysis

1. Open the dashboard to which you want to add the analysis.
2. Click your user image or name in the global area, and select Edit Pages.
3. With the Add Content tab open in the page editor, click the Add Content button where you want the analysis to go.

   The Reports and Analytics folder in the Add Content dialog box contains what's in the BI catalog.
4. Click through the folders in the catalog until you see the name of the analysis, and click Add to include all views of the analysis.

   If you instead click Open or the name of the analysis, you can select a specific view to add.
5. Click Close after you see the analysis added to the dashboard.
6. Click Close to save your changes and close the editor.
How to Tune Performance for Analytics and Reports

When you create analytics and reports, don’t use blind queries and include sufficient filters when creating analytics or reports with hierarchies.

Blind Queries

Avoid blind queries because they are performed without filters and therefore fetch large data sets. Performance could be an issue with these queries and can easily overload the application. All Transactional Business Intelligence queries on large transaction tables must be time bound. For example, include a time dimension filter and additional filters to restrict by key dimensions such as worker. In addition, apply filters to columns that have database indexes in the transaction tables. This ensures a good execution plan is generated for the Business Intelligence query.

Hierarchies and Trees in Transactional Business Intelligence

Queries on trees and hierarchical dimensions such as manager can have an impact on performance. Transactional Business Intelligence uses a column-flattening approach to quickly fetch data for a specific node in the hierarchy. Still, because there is no pre-aggregation for the different levels of the hierarchy, carefully craft any query involving hierarchies to ensure that sufficient filters are applied to keep the result set small.

Review SQL Statements Used in Analyses

You can review logical and physical SQL statements using either of the following procedures.

Logical and Physical SQL

Logical SQL is non-source specific SQL that is issued to the Oracle BI Server for an analysis. Logical queries use column names from the Presentation Layer in the repository (RPD) metadata. Based on the logical request, the BI Server issues optimized source-specific SQL to the actual data sources in the Physical Layer of the repository metadata. If you have proper administrative privileges, you can review both logical and physical SQL for analyses.

Using Analysis in Edit Mode

1. Open the analysis in Edit mode and click the Advanced tab.
2. In the SQL Issued section, review the logical SQL statement.

Using Administration Page

1. On the Administration page, in the Session Management section, click the Manage Sessions link.
Note: You must be a Business Intelligence Administrator to access the Administration and Manage Sessions page.

2. On the Manage Sessions page, in the Action column, click the View Log link to review the SQL statement.

Localize Catalog Captions

As an administrator, you can localize the names of reporting objects that users create (known as captions) in the catalog. For example, you might localize the names of dashboards and analyses into Spanish and French.

To localize object names in the catalog, you export the captions from the catalog, localize them, and upload back to the catalog.

1. Export the default captions to an XML file.
2. Localize the downloaded XML file.
3. Upload the localized XML file.

After translated caption XML is uploaded, translated strings take effect once the cache refreshes. Translated strings are protected during an upgrade.

Export Captions from the Catalog

To export captions:

1. Click **Administration**.
2. Click **Export Captions**.
3. Click **Browse** and select the folder you want to localize in the catalog, then click **OK**.
4. Save the XML file.

Localize Your Captions

Translate the XML file into one or more languages.

Upload Localized Captions to the Catalog

After you have localized captions, upload the translated XML files, one for each language.

To import a translated XML file:

1. Click **Administration**.
2. Click **Import Captions**.
3. Click **Browse** and select the localized XML file, then click **OK**.
4. Use the Select Language option to select the language to which you have localized, then click **OK**.
5. Save the XML file.

To download, review, or delete imported captions files, use the **Manage Captions** option.
Move Analytics

You can archive to bundle the entire catalog, specific folders, or multi component objects as a .catalog file and upload the .catalog file to unarchive the data to another location in the catalog. Use the archive process to transfer specific data across environments, for example from a development environment to a production environment.

Creating an Archive

To create an archive file:

1. Locate the object in the catalog.
2. Select More and then select Archive.
3. In the Archive dialog box, select one or more of the following options:
   - Keep Permissions: Maintain the object or folder's existing permissions. If you do not select this option, then the archiving process does not include any permissions. Upon unarchiving, the parent folder's permissions are assigned to all of the objects and folders.
   - Keep Time stamps: Maintain the Creation Time, Last Modified, and Last Accessed times assigned to the object or folder. Upon unarchiving, the LastModified time is updated to indicate the time at which the object or folder is unarchived. If you select this option, the Old option in the Paste Overview area of the Preferences dialog box is available when unarchiving. You use the Old option to overwrite existing catalog items that are older than the catalog items in the archive. If you do not select this option, then the archiving process does not include time information and the Old option in the Paste Overview area of the Preferences dialog box is not available.
4. Click OK to download the archive file.

Moving a File to a New Location

To unarchive a file:

1. Select the folder in the catalog where you want to upload the archived file.
2. In the Tasks pane click Unarchive.
3. In the Unarchive dialog box, browse for and select the archive file.
4. Use the Replace option to specify whether to replace an existing folder or object with the same name.
   - All: Select this option to replace any existing folders or objects with the same names as folders or objects included in the archive file that you are uploading.
   - Old: Select this option to replace folders or objects except those folders or objects that exist, unless they are older than the source.
   - None: Select this option to add any new folders or objects, but preserve any existing folders or objects.
   - Force: Select this option to add and replace all folders or objects.
5. Use the ACL option to specify how the folders or objects are assigned permissions using Access Control Lists (ACLs) when unarchived.
   - Inherit: Inherits the folder or object's permissions (ACL) from its new parent folder.
   - Preserve: Preserves the folder or object's permissions (ACL) as it was in the original, mapping accounts as necessary.
Create: Preserves the folder or object's permissions (ACL) as it was in the original, creating and mapping accounts as necessary.

6. Click OK.

Row Limits in Analyses

When you run an OTBI analysis that contains more than 65,000 records, the results are limited to 65,000 records due to a limit on the maximum number of records for analyses in cloud environments. Exports to Excel are limited to 25,000 rows and 50,000 cells.

It's recommended that you use BI Publisher reports to export large data sets.

About Warehouse Column Errors in Transactional Analyses

In some OTBI analyses and dashboards, users may encounter errors on some columns in their analyses in cases where non-transactional data sources are being queried.

Some subject areas and analyses in the OTBI catalog for offerings including Oracle Customer Experience include analyses which query subject area columns which map to data warehouse data, which is part of Oracle BI Applications and Oracle Transactional Business Intelligence Enterprise (OTBI-E) and is used for historical analysis. In cases where historical warehouse data is included in transactional analyses, users may encounter errors on these columns if the warehouse is not set up and configured.

In some cases, but not all, these conditions are managed by Business Intelligence repository (RPD) metadata which supports switching from warehouse to transactional sources using variables.

Apply Preferences in BI Publisher

If you're logged in to BI Publisher, and make changes to preferences, for example time zone and locale, to immediately apply the changes in your BI Publisher session, either:

- Append the $ Premiership=1 parameter to the end of the page URL and re-load the page.
- Log out of BI Publisher and log in again.
Glossary

analysis
A selection of data displayed in one or more views, such as a table or chart, to provide answers to business questions.

analytics
Business intelligence objects such as analyses and dashboards that provide meaningful data to help with decision making.

briefing book
A collection of static or updatable analyses or dashboard pages that you can download, print, and share with others.

business intelligence catalog
The repository where all business intelligence objects, including analyses, reports, briefing books, and agents, are stored. The catalog contains separate folders for personal, shared, and modified objects.

business intelligence repository
The metadata that determines all of the columns, or pieces of data, that you can include in analytics. You can also use the repository as a source of data for reports.

dashboard
A collection of analyses and other content that gives in-depth insight to help with business decisions.

data model
The metadata that determines where data for a report comes from and how that data is retrieved.

EDI
Abbreviation for electronic data interchange.

EFT
Acronym for Electronic Funds Transfer. A direct transfer of money from one account to another, such as an electronic payment of an amount owed a supplier by transferring money from a payer's disbursement bank account into the supplier's bank account.

flexfield
A flexible data field that you can configure such that it contains one or more segments or stores additional information. Each segment has a value and a meaning.
**flexfield segment**
An extensible data field that represents an attribute and captures a value corresponding to a predefined, single extension column in the database. A segment appears globally or based on a context of other captured information.

**global header**
The uppermost region in the user interface that remains the same no matter which page you're on.

**infolet**
A small, interactive widget on the home page that provides key information and actions for a specific area, for example social networking or your personal profile. Each infolet can have multiple views.

**job definition**
The metadata that determines what a job does and what options are available to users when they submit the scheduled process. A job is the executable for a scheduled process.

**prompt**
A parameter that you set when you use analytics, limiting the data in the analysis or in all analyses on the dashboard or dashboard page (tab).

**report**
An output of select data in a predefined format that's optimized for printing.

**role**
Controls access to application functions and data.

**scheduled process**
A program that you run to process data and, in some cases, generate output as a report.

**Style template**
An .rtf template containing style information that's applied to report layout templates to achieve a consistent look and feel across reports.

**subject area**
A set of columns, or pieces of data, related to a specific business object or area.

**Subtemplate**
An .rtf or .xsl format that is defined once and used multiple times within a single report layout template or across multiple layout template files.

**view**
A specific way to present the results of an analysis, for example as a table or graph. Other types of views, such as the title view, show other components of the analysis.
**work area**
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

**workflow**
An automated process that passes a task from one user (or group of users) to another to view or act on. The task is routed in a logical sequence to achieve an end result.